
OMNIC Paradigm Software

OMNIC Paradigm
User Guide

269-335801 Revision A September 2019



© 2019 Thermo Fisher Scientific Inc. All rights reserved. 

Microsoft, Windows and Excel are either trademarks or registered trademarks of Microsoft Corporation in the 
United States and/or other countries. All other trademarks are the property of Thermo Fisher Scientific Inc. 
and its subsidiaries.

For technical support, please contact: www.thermofisher.com

Thermo Fisher Scientific Inc. provides this document to its customers with a product purchase to use in the 
product operation. This document is copyright protected and any reproduction of the whole or any part of this 
document is strictly prohibited, except with the written authorization of Thermo Fisher Scientific Inc.

The contents of this document are subject to change without notice. All technical information in this 
document is for reference purposes only. System configurations and specifications in this document supersede 
all previous information received by the purchaser. 

Thermo Fisher Scientific Inc. makes no representations that this document is complete, accurate or error-
free and assumes no responsibility and will not be liable for any errors, omissions, damage or loss that might 
result from any use of this document, even if the information in the document is followed properly. 

This document is not part of any sales contract between Thermo Fisher Scientific Inc. and a purchaser. This 
document shall in no way govern or modify any Terms and Conditions of Sale, which Terms and Conditions of 
Sale shall govern all conflicting information between the two documents.



Thermo Scientific OMNIC Paradigm User Guide iii

C

Chapter 1 Get Started with OMNIC Paradigm Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1
Welcome . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Manage New and Recent Work from the Dashboard  . . . . . . . . . . . . . . . . . . . 2
Process, Analyze, and Explore Spectra in the Spectral View . . . . . . . . . . . . . . . 3
Automate Repetitive Tasks with Workflows  . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Share Your Work Remotely. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Install OMNIC Paradigm Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Before You Begin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Install OMNIC Paradigm Workstation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Set Up and Connect OMNIC Paradigm Workstation. . . . . . . . . . . . . . . . . . . 7

Update Your OMNIC Paradigm Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
OMNIC Paradigm Software Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

OMNIC Paradigm Software Interfaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Pairing OMNIC Paradigm with Other Thermo Scientific Software  . . . . . . . . 4

OMNIC Paradigm Software Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Plan Your Project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Acquire Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Process Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Analyze the Sample . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Generate Reports and Save Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Next Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Connect to an Instrument Remotely . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Chapter 2 Measure Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Set and Save Measurement Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Set Measurement Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Save Your Measurement Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Import and Export Saved Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Advanced Measurement Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Advanced Measurement Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Apodization Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Measure the Background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
When to Measure the Background  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Background Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Measure the Background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Contents



Contents

Thermo Scientific OMNIC Paradigm User Guide iv

Measure a Sample . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Next Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Chapter 3 Process Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31
Apply Basic Equations to Acquired Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

To Perform Any Spectral Math Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Subtract One Spectrum from Another (A-B) . . . . . . . . . . . . . . . . . . . . . . . . . 34
Add Two Spectra Together (A+B) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Multiply One Spectrum by Another (A*B) . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Divide One Spectrum by Another (A/B) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Using Spectral Math with Data Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Chapter 4 Analyze Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37
Manage Spectral Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Create a New Library  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Add Spectra to a Library  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Extract Spectra from Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Delete Libraries and Compounds  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Identify an Unknown Sample with ATR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Prepare the ATR Accessory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Set Up the Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Consider Your Spectral Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Measure and Analyze the Sample. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
What’s in My Sample?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
What if there isn’t a clear (single) match?. . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
How can I improve my analysis results? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
How to Specify the Spectral Region for the Analysis . . . . . . . . . . . . . . . . . . . 53

Identify an Unknown Sample with Transmission  . . . . . . . . . . . . . . . . . . . . . . . 55
Prepare the Transmission Accessory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Set Up the Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Consider Your Spectral Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Measure and Analyze the Sample. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
What’s in My Sample?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
What if there isn’t a clear (single) match?. . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
How can I improve my analysis results? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
How to Specify the Spectral Region for the Analysis . . . . . . . . . . . . . . . . . . . 65

Verify Sample Composition with QCheck  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Performing a QCheck Analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Improving Your Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Extract a Spectrum from a Library. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Next Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Quantify Sample Composition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Performing a Quantify Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Improving Your Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Next Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77



Contents

Thermo Scientific OMNIC Paradigm User Guide v

Chapter 5 Use Workflows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
About Workflows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Workflow Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Play Workflow Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Workflow Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Create and Run Your First Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Create a Workflow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Add Tiles to a Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Tips on Creating Workflows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Workflow Tiles Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Chapter 6 Create Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .114
Create and Share Reports and Export Data . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

Export Settings, Spectra, or Workflows . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

Chapter 7 Protect Your Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .118
Data Security and Integrity with OMNIC Paradigm Software  . . . . . . . . . . . . 119



Thermo Scientific OMNIC Paradigm User Guide 1

1

Get Started with OMNIC Paradigm Software

Welcome to OMNIC Paradigm software. Learn how to install and update your software, 
explore software options, and learn the basics of using OMNIC Paradigm software to measure 
and analyze spectra.

This section includes the following:

Contents

• Welcome

Introduces some of the main features and tools for using OMNIC Paradigm software.

• Install OMNIC Paradigm Software

Provides step-by-step instructions on installing OMNIC Paradigm Workstation software.

• Update Your OMNIC Paradigm Software

Provides instructions on updating OMNIC Paradigm software and configuring your 
update settings.

• OMNIC Paradigm Software Options

Using OMNIC Paradigm software with the desktop or touchscreen interface to optimize 
the software for your work.

• OMNIC Paradigm Software Basics

Learn the basics of measure and analyzing spectra using OMNIC Paradigm software.
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Welcome
Thermo Scientific™ OMNIC™ Paradigm software for desktop and touchscreen is an advanced 
software package for FTIR spectroscopy, designed to simplify how you acquire, process, and 
interpret data and to help you work remotely and collaborate with colleagues around the 
globe.

Manage New and Recent Work from the Dashboard

With the new dashboard in OMNIC Paradigm software, you can set and save your 
measurement settings, measure a new sample, resume your recent work, or run an automated 
workflow all from the same, convenient screen. 

In Paradigm for touchscreen, the home screen provides many of these same tools and features 
in an even more streamlined, intuitive interface so operators can focus on their work and on 
the tools they need.



Welcome

Thermo Scientific OMNIC Paradigm User Guide 3

Learn More

• Set and Save Measurement Options

• Measure a Sample

• Create and Run Your First Workflow

Process, Analyze, and Explore Spectra in the Spectral View

Use the spectral view to process, analyze, or explore your data in depth. Here you can process 
your data, find and label peaks, and optimize the view so you can more easily compare or 
analyze spectra.

The results pane allows you to quickly add or remove a spectrum from the main view, explore 
details of each spectra, or review the change history of your selected spectrum.

Learn More

• Identify an Unknown Sample with ATR

• Identify an Unknown Sample with Transmission
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Automate Repetitive Tasks with Workflows

Automate your tasks with a workflow to ensure that measurements are collected and processed 
in exactly the same way each time. Edit or create a workflow by simply dragging and dropping 
tiles in the workflow editor, and then run the workflow at the click of a button. 

Operators using Paradigm for touchscreen can import and run one of our factory installed 
performance tests or a custom workflow right from the home screen.

Learn More

• Create and Run Your First Workflow

• Workflow Tiles Reference
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Share Your Work Remotely

Upload your data to the cloud and use OMNIC Anywhere to view, analyze or share your data 
using any connected PC, Apple computer, Android or iOS device. 

With a Nicolet™ Summit™ spectrometer and a free Connect account, measure samples in the 
classroom or lab, upload the data to your Connect account, and view, explore, or share the 
data on another device in your dorm or workspace.

Learn More

• View Your Data with the OMNIC Anywhere App
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Install OMNIC Paradigm Software
OMNIC Paradigm software comes preinstalled on the Thermo Scientific™ Nicolet™ Summit 
Spectrometer and is ready to use with the attached touchscreen monitor or with an external 
monitor connected by Mini DisplayPort.

Install OMNIC Paradigm Workstation software on your desktop, laptop, or other device to 
connect to an instrument over an Ethernet or WiFi connection. Connect to an instrument to 
measure a sample and disconnect to allow other operators to use the instrument while you 
analyze your data or develop workflows. 

This guide walks you through installing OMNIC Paradigm Workstation software. 

Before You Begin

Your system should meet the recommended system requirements outlined below to run and 
use OMNIC Paradigm Workstation software.

Recommended System Requirements

Install OMNIC Paradigm Workstation

Installing OMNIC Paradigm Workstation takes only a few minutes. 

 To install OMNIC Paradigm Workstation software

1. Insert the provided installation media (either DVD or flash drive).

2. Run the installer.

a. When the download completes, run the OMNIC Paradigm.exe file.

Operating System Windows 10 (64-bit)

Processor Intel Core i5 3.3GHz

RAM 8 GB 

Hard Disk 2 GB of available hard-disk space for installation; Additional 
hard-disk space recommended for storing files. 

If you are hosting your database on this machine, we recommend 
500 GB of hard-disk space. 
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b. Follow the on-screen prompts to install OMNIC Paradigm Workstation software.

Set Up and Connect OMNIC Paradigm Workstation

By default, data is saved to the database on your local device. If you connect to a Nicolet 
Summit Spectrometer, you can continue using your local database, or you can connect to the 
database on the instrument or another database located on your network. 

 To connect to a default database

1. Open OMNIC Paradigm Workstation software.

2. Select Configure > Database.

3. In the Database Engine list, select Thermo Scientific Built-in Database.

4. Enter the server address or URL for your database. The server address or URL is the name 
of the instrument that you want to connect to on your network. 



Thermo Scientific OMNIC Paradigm User Guide 1

Update Your OMNIC Paradigm Software
We recommend that you install the latest updates for OMNIC Paradigm software to ensure 
that you can take advantage of new features and stability improvements.

The latest version of OMNIC Paradigm software is 1.0.

 To update OMNIC Paradigm software (desktop interface)

1. Using the desktop interface, open the Configure menu and select Update.

2. In the Update Configuration dialog, click Browse and navigate to the local or network 
directory where updates will be stored.

Once you have configured the directory for updates, any new versions of OMNIC 
Paradigm software in this location are automatically recognized. The software 
automatically checks this location for updates once daily, but you can return to this dialog 
to manually check for updates at any time.

A prompt notifies you when new updates are available.

3. Click Check for Updates. After a brief scan, a list of available updates is displayed.

4. From the list of available updates, select the version you would like to install and click 
Install Update. Follow the on-screen installation prompts.

You can also configure updates using the touchscreen interface by opening the Settings view 
and navigating to the Application Updates tab.

Note  Your spectral data and saved measurement settings will be carried over to the new 
version. No data will be lost in the update.
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OMNIC Paradigm Software Options
OMINIC Paradigm software features three interfaces to suit your device or task and pairs 
with other Thermo Scientific software, allowing you to develop and run quantification 
methods or protect and audit your data. 

OMNIC Paradigm Software Interfaces

Switch anytime between OMNIC Paradigm software’s touchscreen and desktop interfaces to 
best suit your device and goals.

Touchscreen Interface

Figure 1. The touchscreen interface features a simplified interface for streamlined analysis.

The touchscreen interface is optimized for small screens, such as the Thermo Scientific™ 
Nicolet™ Summit spectrometer’s optional touchscreen device.

Use the touchscreen interface for measuring and analyzing samples or running workflows in a 
streamlined, simplified interface. 
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Desktop Interface

Figure 2. The desktop interface includes a wider range of features and tools for more complex 
measurements and analyses.

Use the desktop interface when working from a larger screen and when you need additional 
features not available in the touchscreen interface, such as the workflow editor and select 
spectral processing and analysis tools.

Connect your Summit spectrometer to an external monitor and a USB mouse and keyboard 
for the best experience using the desktop interface.

Switching Between Interfaces

Although desktop and touchscreen software are optimized for different tasks and devices, you 
can switch between interfaces at any time. 

 To switch between the touchscreen and desktop interfaces

• To switch from desktop to touchscreen, select View / Display > Switch to Touchscreen.

The software will close briefly and re-open with the touchscreen interface.

• To switch from touchscreen to desktop, from the home screen, select Switch to Desktop 
from the menu.

The software will close briefly and re-open with the desktop interface.
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Pairing OMNIC Paradigm with Other Thermo Scientific Software 

OMNIC Paradigm software is compatible with other Thermo Scientific software for added 
flexibility and for quantitative analysis and data security. 

OMNIC Paradigm Workstation software

Figure 3. Workstation software lets you analyze spectra or develop workflows while you’re away 
from a spectrometer

When working from a separate computer and not connected to an instrument, use 
Workstation software to analyze previously collected data, create workflows for later use, or 
create and share reports. 

Quantitative Analysis Software

Pair OMNIC Paradigm software with TQ Analyst™ software to develop and run quantitative 
analysis methods that you can use in OMNIC Paradigm software. 

• TQ Analyst EZ Edition
• TQ Analyst Professional Edition

See “TQ Analyst™ Pro Edition Software” on thermofisher.com for details.

Data Security Software

Use Thermo Scientific™ OMNIC™ Security Suite Software to ensure your data’s security and 
integrity. The Security Suite software ensures 21CFR Part 11 compliance and includes the 
following:

• Security Administration for controlling system access, handling security policies, and 
setting digital signatures for responsibility and data integrity
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• Audit Manager for creating and managing complete audit trails

• Thermo Software IQ tool to verify your security installation

See “OMNIC™ DS Data Security Software” for more on securing your data with Security 
Suite software.

https://www.thermofisher.com/order/catalog/product/OMNICDS
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OMNIC Paradigm Software Basics
Understanding the core concepts of using OMNIC Paradigm software will help you more 
efficiently and effectively collect, analyze, and report spectral data. 

You may not always carry out every step of the following process, and you can customize 
OMNIC Paradigm software to meet your specific needs, but in general, you will likely follow 
a common process:

Plan Your Project

Before getting started with the software, it’s important to consider your project goals. 
Planning in advance will help you decide what type of processing and analysis is appropriate 
for your work, what measurement settings will yield the best data, and how you can most 
efficiently carry out your procedures. 

Before acquiring data, you should be able to answer the following questions:

• What are my goals for the project? 

For example, do you want to identify an unknown sample or verify that your sample is 
meeting your standards. With OMNIC Paradigm software, you can run different 
processes and analysis steps depending on how you will use the data. Common goals 
include the following:

• Identify a pure sample 

• Identify the components of a mixture 

• Verify that a sample meets your specifications

• Quantify the components of a sample 
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• How will I measure my sample?

OMNIC Paradigm software supports a variety of spectrometer sampling accessories and 
measurement techniques. 

See “FTIR Sample Handling Techniques” on FTIR Spectroscopy Academy for a full 
discussion of choosing the best collection method for your specific work.

• Am I planning only a few measurements or will this be a routine, repeated procedure?

If you would like to automate a routine procedure, you can create a workflow. With a 
workflow, you specify settings for data collection, provide instructions to operators, and 
define data processing, reporting, and archiving in advance. You or other operators can 
then use the workflow to carry out procedures with the knowledge that exactly the same 
steps will be taken each time.

For a step-by-step guide on creating a new workflow, see “About Workflows.” 

Acquire Data

Once you have a plan for collecting and working with your data, you’re ready to start 
measuring samples. Generally, to measure a sample and collect data, you will follow these 
steps:

1. Prepare the spectrometer, sampling accessory, and sample to be measured.

Usually, you should make sure your spectrometer, sampling accessory, and sample are 
ready before you begin. This can mean ensuring the spectrometer is warmed up and 
functioning well, that the sampling accessory is installed, and that the sample is prepared. 

The specific steps for setting up the spectrometer and accessory will vary depending on 
the instrument and on your sample. See the user guides and tutorials for your instrument 
for specifics on preparing your spectrometer. Or, see FTIR Spectroscopy Academy for 
more on handling and measuring samples.

Note that you must measure the background without the sample present. The best time 
to collect a background spectrum will vary by the type of sample you are measuring. 

2. Select or edit your measurement settings.

When the instrument is ready, you can adjust settings both for how the software will 
collect and process the data and for setting up the spectrometer. Select your saved settings 
from a menu on the dashboard or edit settings individually for a single measurement.

See “Set and Save Measurement Options,”  for a discussion of how to edit and save 
measurement settings.

https://www.thermofisher.com/us/en/home/industrial/spectroscopy-elemental-isotope-analysis/spectroscopy-elemental-isotope-analysis-learning-center/molecular-spectroscopy-information/ftir-information/ftir-sample-handling-techniques.html
https://www.thermofisher.com/us/en/home/industrial/spectroscopy-elemental-isotope-analysis/spectroscopy-elemental-isotope-analysis-learning-center/molecular-spectroscopy-information/ftir-information.html
https://www.thermofisher.com/us/en/home/industrial/spectroscopy-elemental-isotope-analysis/spectroscopy-elemental-isotope-analysis-learning-center/molecular-spectroscopy-information/ftir-information.html
https://www.thermofisher.com/us/en/home/industrial/spectroscopy-elemental-isotope-analysis/spectroscopy-elemental-isotope-analysis-learning-center/molecular-spectroscopy-information/ftir-information.html
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3. Measure the background.

When you measure a sample, the spectrometer records data from the sample as well as 
from the environment in the spectrometer. To ensure that your sample spectrum 
represents only your sample, without any data from the background environment, you 
must measure the background. The background spectrum is then compared to (or ratioed 
against) the sample spectrum and any data from the background is accounted for, leaving 
you with data from only your sample.

See “Measure the Background,”  for a full discussion of when and how to collect a 
background spectrum.

4. Measure the sample.

Finally, you can measure the sample. During the measurement, you can preview the 
spectrum and refine your measurement settings before proceeding. If you indicated an 
analysis type in the settings, the data will automatically be processed after collection.

Once the data are collected, you will be able to view and explore the spectrum in the 
spectral view.

Process Data

After you measure your sample, it’s often helpful to process your data so that it is easier to 
analyze or compare to other spectra. Common spectral issues that OMNIC Paradigm 
software can help you correct include the following:

• A sloping, curving, shifted or otherwise undesirable baseline

• Peaks obscured by noise in the data

• Variation in depth of penetration from an ATR measurement

• Totally absorbing peaks from too thick of a sample

• Issues caused by CO2 or H2O in the atmosphere

Analyze the Sample

OMNIC Paradigm software has tools designed to help you carry out common analyses and to 
explore spectral data in-depth. Common types of analysis include the following:
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• Identify an unknown sample or mixture

To identify an unknown sample or the components of a mixture, compare the spectrum 
of your sample to reference spectra that are stored in spectral libraries. Spectral libraries 
are collections of spectra and usually contain additional information on the stored 
compounds. Libraries can be created or they can be purchased. When you run a 
correlation or multi-component search, the software searches your stored libraries and 
finds spectra that are similar to your sample spectrum and indicates how closely the 
spectra match. 

For more on spectral libraries, see “Manage Spectral Libraries.” 

For more on identifying an unknown sample, see “Identify an Unknown Sample with 
ATR.” 

• Verify the composition of a sample

You can quickly verify that a sample meets your specifications by using QCheck. With 
QCheck, you can compare two selected spectra or compare one or more spectra with a 
reference spectrum or spectral group. QCheck results show the degree of similarity 
between the spectra as a match value from 0.0 (no similarity) to 1.0 (the spectra are 
identical). 

• Find the concentrations of components in a sample

Quantitative analysis methods that you have created in TQ Analyst software are available 
for use in OMNIC Paradigm software. You can select these quantification methods and 
run the quantification analysis from the OMNIC Paradigm dashboard. 

• Perform custom, in-depth analysis

OMNIC Paradigm software features many tools to help you to explore the spectra 
further. For example, the Find Peaks tool lets you quickly identify and label peaks, or you 
can subtract one spectrum from another or perform other operations using Spectral 
Math.

Generate Reports and Save Data

Once you have collected, processed, or analyzed your data, you’ll likely want to store or share 
it. With OMNIC Paradigm software, you can customize how your data is stored or exported.

• Exporting reports

When it’s time to share your data, you can generate reports automatically using templates. 
Templates can include results from library searches, QCheck, quantification methods, 
and more, or they can be used to send data directly to Microsoft Word, Excel, or 
PowerPoint.



OMNIC Paradigm Software Basics

Thermo Scientific OMNIC Paradigm User Guide 10

• Storing data

By default, the software is configured to store data in a MariaDB Server database, but you 
can also configure the software for other databases, such as Oracle Database or Microsoft 
SQL Server.

Additionally, settings, spectra, and workflows can be exported as files that you can 
backup, store, or share.

For a discussion of data security options in OMNIC Paradigm software, see “21 CFR Part 
11 Compliance.”

Next Steps

You may not always follow every step of the process described in this guide, but in general, 
you will be able to achieve better results by understanding the overall process and capabilities 
of using OMNIC Paradigm software.

Next, get started by measuring your first samples, reviewing setup of your spectrometer, or 
creating a workflow to automate routine procedures. 
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Connect to an Instrument Remotely
Connect to an instrument on your local network to measure a sample or run a workflow while 
you are away from the instrument.

 To connect to a remote instrument

1. In the desktop interface of OMNIC Paradigm software, select Configure > Connectivity 
from the menu.

2. Select an instrument from the list of available instruments or enter the IP address or 
hostname of the instrument to which you would like to connect. 

3. Click Connect. 

OMNIC Paradigm software closes and restarts during connection. It may take several 
moments to re-open and to complete connection to the instrument. 

If the instrument is already in use, click Request Access to send a request to use the 
instrument. The current user can then grant or deny access.

While you use the instrument remotely, it displays a message indicating that it is in use 
and allows local users to request access.
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Measure Samples

To acquire new data with OMNIC Paradigm software, set and save your measurement 
settings, collect a background spectrum, and finally measure the sample.

Contents

• Set and Save Measurement Options

Describes common measurement settings and their values, with suggestions for when you 
might make changes

• Advanced Measurement Settings

Describes settings for the instrument and sampling accessory, as well as other less 
commonly used settings

• Measure the Background

Provides a brief overview of background spectra and describes the procedure for 
measuring the background

• Measure a Sample

Describes the procedure for measuring a sample using OMNIC Paradigm software
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Set and Save Measurement Options
Measurement settings allow you to specify how your sample is measured and how the data is 
processed after the spectrum is collected. Your settings control both how the instrument and 
sampling accessory measure the sample and how OMNIC Paradigm software processes the 
data.

After adjusting your measurement settings, you can use them immediately or save them for 
later use.

This guide describes how to set, save, and use common measurement options. For a 
discussion of advanced settings, see “Advanced Measurement Settings.” 

Set Measurement Options

Set and save your measurement settings or use previously saved settings before starting a 
measurement. 

In OMNIC Paradigm software for touchscreen, edit individual settings or import a settings 
file (.expx) before you measure your sample. To edit or review measurement settings, select an 
analysis type from the home screen.

Figure 1. Review measurement settings in the Summary, Details, and Background tabs
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When using the desktop interface, set and save your measurement settings from the 
dashboard, or update a few options while previewing a sample spectrum.

Figure 2. Edit measurement settings in the New Measurement pane.

The following table describes the settings you will use most frequently.

Option Description Default Setting

Measurement name The name of your sample data. This name will 
appear when you save or open this data and in 
any reports you generate. The default name is 
the date and time of collection.

Date and Time

Number of sample 
scans

How many times the sample is scanned during 
the measurement. The resulting data reflects 
the average of all the scans.

More scans will result in more accurate data 
but will take longer to measure.

10

Resolution (cm-1) Like the resolution of a photo or video, a better 
resolution will mean finer detail in your 
spectral data. For example, a better resolution 
will distinguish between two very close peaks 
while a poor resolution might combine them.

A smaller value results in a higher (better) 
resolution, but also takes longer to measure. 

Typically, resolutions of 4 are used for solid and 
liquid samples. For gas samples, use a 
resolution of 1 or 0.5.

4
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Save Your Measurement Settings

You can save, edit, or delete your measurement settings only when using the desktop interface.

Name and save your measurement settings so that you can easily select them from the 
dashboard for later use. Settings for Search, QCheck, and Quantify analyses are not saved in 
these settings.

 To save your measurement settings

1. Make any desired changes to the settings.

Analysis type With OMNIC Paradigm for touchscreen, you 
select your analysis type from the home screen 
rather than selecting from a list.

Allows you to automatically process your data 
after it’s collected.

Use None to measure a sample without 
additional analysis.

Search performs a correlation search. Use 
search to identify an unknown sample. Edit 
search settings in the Search Setup view.

QCheck results indicate a match value between 
your sample and a reference. Use QCheck to 
verify the composition of a known sample. Edit 
QCheck settings in the QCheck Setup view.

Quantify is used to quantify the components 
of a sample using a pre-selected quantification 
method. Select Identify > Quantify Setup to 
specify a quantification method.

None

Tag Allows you to add a tag to the spectrum. Tags 
can later be used when searching for a 
spectrum.

Final format Determines the units used for the collected 
data. You can convert your data to another 
Y-axis unit after collection in the View/Display 
menu.

Absorbance

Sampling accessory The sampling accessory used to measure the 
sample. Smart accessories are detected 
automatically.

Option Description Default Setting
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2. Click in the Settings menu at the top of the dashboard.

3. Enter a new name for the settings and click Save.

Saved settings are added to the Settings list for later use.

 To make changes to your saved settings 

1. Select the named settings that you want to update from the Settings menu.

2. Edit the settings

3. Without entering a new name for the settings, click Save.

4. Click Update in the confirmation dialog to save your changes.

Your new settings are now saved under the old setting name and are available in the 
Settings menu.

 To delete your saved settings

1. Select the named settings you want to delete from the Settings menu.

2. Click Delete.

3. In the confirmation dialog, click Yes to permanently delete the named settings. 

Import and Export Saved Settings

Import a settings file to automatically update your current measurement settings to those you 
saved previously. When importing settings, you can import an OMNIC Experiment file 
(.exp) or an OMNIC Paradigm settings file (.expx). 

OMNIC Paradigm software is compatible with .exp files that were created with OMNIC 
software. However, with OMNIC Paradigm, you can export only .expx files, which are not 
compatible with earlier versions of OMNIC software.

Importing an OMNIC Experiment file updates your measurement settings, but does not alter 
your analysis settings, such as Search Setup or QCheck Setup. 

 To import a settings file

• If you are using the touchscreen interface

a. From the home screen, select an analysis type.

b. While viewing the Summary tab, open the menu and select Open Settings.

c. Select an OMNIC Experiment file (.exp) or OMNIC Paradigm settings file (.expx) 
file to import and touch Open.

• If you are using the desktop interface

a. In the toolbar, click Settings.
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b. Select the file to import and click Open. 

 To export a settings file

Settings can be exported only from the desktop interface. Settings files are saved with a .expx 
file name extension.

1. Choose the settings you wish to export from the Settings list

2. Select Acquire Data > Export Settings.

3. Enter a name for your settings file, select a directory to save the file, and click Save.

The settings file is now saved and ready for future use.
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Advanced Measurement Settings
Use advanced measurement settings to control apodization, zero fill, range limits, 
instrument-specific settings, and more.

These advanced settings should typically be left in their default state. Only in rare or specific 
circumstances should you edit these settings. 

To review or edit advanced settings in the touchscreen interface, open the Details tab.

Figure 1. The Details tab displays advanced measurement settings.

To review or edit advanced settings in the desktop interface, click More in the New 
Measurement pane.
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Figure 1. Advanced measurement settings are available from the dashboard

Advanced Measurement Settings

The following table describes each of the advanced settings.

Option Description Default Setting

Detector The detector is a device inside the spectrometer 
that produces an electrical signal in response to 
the infrared beam striking it. 

The detector setting is updated automatically 
based on your spectrometer setup. 

• Nicolet Summit: DTGS. 
• Nicolet Summit Pro: TEC DTGS.

Gain Gain is used to increase the intensity of weak 
detector signals. A greater amount of gain will 
amplify a weak signal, which can occur with 
some sampling accessories.

1

Optical velocity Determines the optical velocity in the 
interferometer. The default value is determined 
by the type of detector you are using, and can 
only be changed on certain spectrometers. 

On the Nicolet Summit spectrometer, the 
default value is 0.4747 and cannot be changed.
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Zero fill Interpolates data points between the collected 
data points. This doesn’t increase the actual 
resolution of the data, but can smooth out 
sharp features and improve the line shape of a 
spectrum.

Collect your sample and background spectra 
using the same Zero Fill setting.

Options

• None: No zero filling is done.

• 1: One data point is added between each 
collected data point

• 2: Three data points are added between 
each collected data point

2

Source The component inside the spectrometer that 
emits the infrared radiation that travels to the 
detector.

The source type is determined by your 
spectrometer setup. See your spectrometer user 
guide for details on the source.

Apodization Apodization refers to a mathematical function 
that is applied to the single beam data to reduce 
or remove peak side-lobes that can occur 
because the interferogram is not an infinite set 
of data.

Strong apodization reduces more noise but can 
also reduce the resolution of the data and 
broaden peaks.

You may want to consider weaker apodization, 
such as Boxcar, if you are measuring spectra 
with very narrow peaks, such as high-resolution 
gas spectra.

See Apodization Functions for a description of 
each type of apodization.

Norton-Beer 
Strong

Option Description Default Setting
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Apodization Functions

Apodization refers to a mathematical function that is applied to the single beam data to 
reduce or remove peak side-lobes that can occur because the interferogram is not an infinite 
set of data. 

Strong apodization reduces more noise but can also reduce the resolution of the data and 
broaden peaks.

See FTIR Spectroscopy Academy for a general introduction to apodization.

Automatic 
Atmospheric 
Suppression

Suppresses the effects of water vapor and 
carbon dioxide on the spectra you have 
collected.

In general, it is better to control for 
atmospheric conditions using a current 
background spectrum. If you measure the 
background frequently or if atmospheric 
conditions change slowly, there is no need to 
use this feature.

Use this feature only if you measure the 
background infrequently or when atmospheric 
conditions change rapidly.

Deselected

Range Limits Sets the limits for the range of frequencies, in 
wavenumber, included in the collected 
spectrum.

Max: 4,000

Min: 400

Aperture Controls the intensity of the infrared radiation 
that reaches the sample.

Aperture can only be changed when using 
spectrometers with adjustable apertures.

In general, larger apertures will result in a 
better signal-to-noise ratio while smaller 
apertures result in better stability and accuracy. 
Small apertures are better for high-resolution 
measurements.

You may need to use small apertures to acquire 
true high-resolution spectra.

Option Description Default Setting

https://f1.media.brightcove.com/12/665001591001/665001591001_4396039527001_Apodization-Basics.mp4?pubId=665001591001&videoId=4395834000001
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The following table describes the available apodization types:

Setting Description

Boxcar The interferogram is unweighted; that is, the data are simply 
truncated at the beginning and end. Use this type when you 
are measuring a gas sample, want maximum resolution and are 
not concerned about ringing effects (side lobes). The greatest 
amount of ringing will be present with this type.

Cosine This setting suppresses side lobes and only moderately 
degrades the resolution of the spectrum. This setting is similar 
to the Happ-Genzel and Norton-Beer medium apodization. 
Cosine is normally used only to reproduce the results of other 
experiments that used it.

Happ-Genzel Suppresses side lobes more effectively than the Triangular type 
and with less reduction in resolution than that type. (It results 
in more reduction in resolution than the boxcar type.) 

Norton-Beer Weak This setting has a less pronounced smoothing effect on data 
than do the Norton-Beer Medium and Norton-Beer Strong 
types and degrades the resolution less than those types. Side 
lobes appear on both sides of peaks and are more pronounced 
for sharper peaks. 

Use this setting only when the best possible resolution is 
required. This setting is generally not recommended and is 
normally used only to reproduce the results of other 
experiments that used it.

Norton-Beer Medium This type has a smoothing effect on data which is between that 
of the Norton-Beer Weak and Norton-Beer Strong types. It 
suppresses side lobes as much as possible given that it only 
moderately degrades the resolution of the spectrum. The side 
lobe suppression is more significant than for Norton-Beer 
Weak apodization. This setting is suitable for most normal 
samples; it gives results virtually identical to those obtained 
with Happ-Genzel.

Norton-Beer Strong Norton-Beer Strong is the recommended apodization for 
the Nicolet Summit and Summit Pro spectrometers.

This setting has a greater smoothing effect on data than do the 
Norton-Beer Weak and Norton-Beer Medium types and 
degrades the resolution of the spectrum more. The side-lobe 
suppression is more significant than for Norton-Beer Medium 
apodization.
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Triangular Mathematically weights interferogram data to reduce ringing 
effects (side lobes), resulting in lower resolution than that 
obtained with the boxcar and Happ-Genzel types. Some 
ringing will usually be present with this type. This setting is 
normally used only to reproduce the results of other 
experiments that used it.

Blackman-Harris The 4-term Blackman-Harris function is a strong apodization 
function that is better than any of the others at suppressing 
side lobes. However, it results in greater line broadening than 
any of the others. In practice this has the effect of reducing 
random noise in a spectrum while causing band broadening.

Setting Description
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Measure the Background
Accurate sample spectra require an accurate and current measurement of the background.

When you collect a background spectrum, you are collecting a measurement of the 
environment in the spectrometer without a sample in place, including characteristics of the 
detector and atmosphere inside the spectrometer. This background spectrum is then used to 
eliminate any signals in your sample spectrum that are due to the spectrometer or to the 
background environment. Without a measurement of the background, there would be no way 
to know whether you were seeing data from the sample you measured or from the background 
environment.

When to Measure the Background

Because the background environment in the spectrometer can change over time, you should 
update your background spectrum frequently. 

In addition to collecting a new background spectrum periodically as the environment 
changes, collect a new background after any of the following circumstances:

• You have changed the hardware in your spectrometer, including changing sampling 
accessories

• You have changed the settings for measuring samples

Background Settings

There are several options for when and how to measure the background. These options 
determine when and if you are prompted to collect a new measurement of the background.

To select a different background option in the touchscreen interface, select an analysis option 
and open the Background tab.

To select a different background option in the desktop interface, click More in the New 
Measurement pane of the dashboard and scroll to the Background group. 



Measure the Background

Thermo Scientific OMNIC Paradigm User Guide 25

Figure 1. In the touchscreen interface, select a background setting in the Background tab.

Figure 1. In the desktop interface, select a background setting in the Background pane.

The following table describes the background settings.

Setting Description

Background scans How many times the background will be measured. The resulting 
spectrum represents the average of all scans. More scans will 
produce a more accurate spectrum but will require a longer 
collection time. The default is 10.

Measure before every 
sample

If this option is selected, you will be prompted to collect a new 
background spectrum before every sample measurement. This is a 
good option when you are measuring only a few samples, as it 
ensures a current measurement, but it can slow down the 
measurement process.

Measure every ___ 
min

Allows you to measure many samples using the same background 
spectrum. You can enter any integer value between 1 and 1024, but 
note that the background environment may change over time and 
your sample spectra may become less accurate as time passes.
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Measure the Background

Measuring the background requires on a few simple steps. If you attempt to measure a sample 
without a current background spectrum, you will be prompted to measure the background 
before proceeding.

 To measure the background in the desktop interface

1. Remove any sample from the sampling accessory.

2. From the dashboard, select Preview and Measure Background.

The Background Preview window opens, and you can preview the background before 
continuing with the collection.

3. To continue, select Start Background Measurement, or click Dashboard in the toolbar 
to cancel and return to the dashboard.

During the measurement, you can pause, restart, or stop the collection. If you stop the 
collection, the partial data will be used. For example, if you plan to collect 8 scans, but 
you stop after 4, the background spectrum will be used with only 4 scans.

Once the background spectrum is collected, you can preview the sample spectrum and 
make any necessary changes to the sample measurement settings, or you can return to the 
dashboard.

 To measure the background in the touchscreen interface

1. From the home screen, select an analysis type.

2. Open the Background tab to edit or review your background settings.

3. To begin the measurement, touch Measure Background.

The Background Preview opens, and you can preview the background before proceeding.

4. To proceed, touch Start Background Measurement.

Smart background Smart background measures the background automatically, so that 
you always have a current measurement without having to 
manually measure the background. 

Use previous 
background

Allows you to select a previous background spectrum. This option 
should be used only rarely and under unusual circumstances (for 
example, if it would be impossible to load or remove the sample 
without changing the system environment). In this case, you 
would collect and save a background spectrum earlier, using 
conditions as close as possible to the conditions under which you 
will measure the sample.

Setting Description
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During the measurement, you can pause, restart, or stop the collection. If you stop the 
collection, the partial data will be used. For example, if you plan to collect 8 scans, but 
you stop after 4, the background spectrum will be available with 4 scans.

Once the background spectrum is measured, you can preview the sample spectrum and 
make any necessary changes to the sample measurement settings, or you can select Home 
in the menu to return to the home screen.
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Measure a Sample
Measuring a sample requires you to prepare your sample, to set and save your measurement 
settings, to measure a background spectrum, and finally to measure the sample.

 To measure a sample using OMNIC Paradigm software for touchscreen

1. Prepare your sample 

How you prepare your sample will depend on your spectrometer and sampling accessory. 
For details on preparing and loading the sample, see your sampling accessory’s user guide.

2. Select the analysis type that reflects the analysis that you are performing. To measure a 
sample without performing additional analysis, select Measure.

After selecting an analysis type, the settings summary view opens.

Figure 1. The Summary tab displays common measurement settings.

3. Review and edit your measurement settings. 

Open the Details tab to review additional measurement settings or open the 
Background tab to adjust settings for how the background is measured. Depending on 
your background settings, you may be prompted to measure a new background before 
measuring the sample.

See “Set and Save Measurement Options” for a description of each setting.

For details on setting up your analysis, see “Identify an Unknown Sample with ATR.”  
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4. When you are satisfied with your settings, touch Measure Sample. The sample preview 
opens and displays a live preview of the spectrum.

5. To proceed, touch Start Sample Measurement.

During the measurement, you can pause, restart, or stop and save your measurement. For 
example, if you feel your data are sufficient and you do not want to wait for more scans, 
touch Stop to save and use the data as is. Touch Restart to clear all data and begin 
scanning from the beginning. 

Once your sample is measured, you can process or analyze it in the spectral view, or you can 
measure another sample. To measure another sample from the Spectral view, touch Measure 
New Sample. 

 To measure a sample using OMNIC Paradigm software for desktop

1. Prepare your sample 

How you prepare your sample will depend on your spectrometer and sampling accessory. 
For details on preparing and loading the sample, see your sampling accessory’s user guide.

2. To edit the settings for a Search, QCheck, or Quantify analysis, open the Identify menu 
and open the corresponding setup option.

3. Set and save your measurement settings. 

To use previously saved settings, select the settings from the Settings list. 

Figure 1. The Settings list displays your previously saved settings

See “Set and Save Measurement Options” for a description of each setting.

For details on setting up your analysis, see “Identify an Unknown Sample with ATR.” 

4. In the New Measurement pane, click Preview and Measure Sample

Depending on your background settings, you may be prompted to measure a new 
background. If so, follow the on-screen prompts to measure a new background. 

While measuring the sample, you can pause, restart, or stop and save your measurement. 
For example, if you feel that your data are sufficient and you do not want to wait for more 
scans, click Stop to save and use the data as is. Click Restart to clear all data and begin 
scanning from the beginning. 

Once your sample is measured, you can process or analyze it in the Spectral view, or you can 
measure another sample. To measure another sample from the Spectral view, click More to 
review common measurement settings, and then click Measure New Sample to begin. 
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Next Steps

Measuring a sample with OMNIC Paradigm software requires only a few simple steps. Before 
measuring the sample, review your measurement settings and ensure that you have a recent 
background spectrum in use. 

With your spectrum measured, you’re ready to identify, verify, or quantity the spectra. See 
“Identify an Unknown Sample with ATR” for a guide to using a library search to identify your 
sample. 
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Process Data

Use the processing tools in OMNIC Paradigm software to better understand your data.

Contents

• Apply Basic Equations to Acquired Data

Perform basic equations, such as add, subtract, multiply, and divide, with your acquired 
sample spectrum.
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Apply Basic Equations to Acquired Data
You can perform basic equations (add, subtract, multiply and divide) with acquired sample 
spectra. There are a number of reasons why you might want to do this, especially for 
subtracting a reference spectrum. For more information, see the sections that follow.

To Perform Any Spectral Math Operation

To perform spectral math, the sample and reference spectra must have the same spectral 
resolution and be in the same Y-axis unit. If they are not, the software automatically converts 
the selected reference spectrum to match the selected sample spectrum. In order to subtract, 
multiply or divide spectra, at least a portion of the spectral range (X-axis) of the two spectra 
must overlap.

 To perform any spectral math operation on a spectrum

1. Acquire or open a spectrum of your sample and make sure that spectrum is selected in the 
spectral view.

2. Choose Process (menu) > Spectral Math.

The software opens the Spectral Math setup window with the sample spectrum in the left 
pane and space for a reference spectrum in the right pane.

Figure 1. Spectral Math Setup Window

Spectrum of 
selected sample

Selected reference 
opens here

1. Spectrum of selected sample
2. Selected reference opens here

3. Selected math operation
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3. Use the settings list between the two panes to select a spectral math operation (Subtract, 
Add, Multiply or Divide).

4. Use the Select Reference list to search for a spectrum in the current project, another 
project, or from a spectral library.

5. Click Subtract (Add, Multiply, Divide) to start the operation.

The software opens the Spectral Math operation window with the two original spectra 
(bottom) and the current result with a factor slide bar (top). Here is an example showing 
a subtraction result:

6. Adjust or enter a factor as needed to increase or decrease the intensity of the reference in 
the result spectrum.

See the sections below for tips on adjusting the factor for each math type.

7. Choose Save.

Note  Use the bottom bar to change the Factor’s adjustable range.

1. Current subtraction result
2. Factor

3. Reference
4. Sample
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The software shows the spectral view with the subtraction result in the spectral pane and 
at the top of the results panel, with the original sample and reference spectra directly 
below it.

Subtract One Spectrum from Another (A-B)

Use Subtract to subtract one spectrum from another. Spectral subtraction is useful in a variety 
of situations. Here are some examples: 

• If you measure a sample that is dissolved in a solvent, the spectrum will contain peaks due 
to the solvent. By subtracting a spectrum of the pure solvent from the sample spectrum, 
you can eliminate the solvent peaks and produce a “clean” spectrum of the sample 
material.

• When you measure a sample that is a mixture of two or more components, the spectrum 
is, theoretically, the sum of the spectra of all the components. By subtracting a spectrum 
of a pure component from the sample spectrum, you can produce a simpler mixture 
spectrum with that component removed. You can then search that spectrum against a 
library to identify the remaining components. (In this case, you might want to try using 
the Multi-Component Search option instead.)

• If you measure a sample that contains an unknown contaminant, the spectrum will 
contain peaks due to the contaminant. By subtracting a spectrum of uncontaminated 
sample material from the first spectrum, you can produce a residual spectrum of the 
contaminant. You can then search that spectrum against a library to identify the 
contaminant.

Note  The result has the same name as the original sample with the type of math operation 
performed (for example, add, subtract, etc.) appended to it.

1. Spectral math result
2. Sample

3. Reference
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• If you collect spectra to monitor the quality of a material being produced, you can more 
easily detect changes from one batch to the next by subtracting one sample spectrum 
from the next (or vice versa) than by just comparing the spectra visually.

Tips on subtracting spectra

• To determine the subtraction factor, watch the changes in the common peaks as you 
change the factor. The common peaks in the result spectrum should become smaller. The 
optimum factor is one which produces nulled (or zeroed) common peaks in the 
subtraction result without subtracting other important spectral information. If you use 
the correct factor, the peaks present in the result will be due solely to the sample material 
of interest.

• The initial subtraction factor is automatically calculated from the displayed region. If you 
display a different spectral region and perform the subtraction again, the difference 
spectrum will probably be different because the subtraction factor changed.

• When you subtract a reference spectrum from a sample spectrum, the baseline regions are 
subtracted along with the regions that contain peaks. If the sample spectrum's baseline is 
not flat and at zero absorbance (or 100% transmittance), the baseline of the subtraction 
result will have the same undesirable characteristics. If you correct the baseline first, you 
can obtain a “clean” subtraction in which corresponding peaks are subtracted out, without 
baseline problems in the result.

• When you subtract the spectrum of a pure reference material from that of a mixture, the 
peaks may not subtract cleanly. This is because the reference spectrum does not account 
for any changes that may occur due to molecular interactions with the other components 
in the mixture or differences in relative concentrations of components. These conditions 
may cause some peaks to shift slightly or change shape.

Add Two Spectra Together (A+B)

Use Add to add two spectra together. Adding spectra can be useful in the following situations:

• Add can be used to join together two spectra of different spectral ranges.

• By adding two pure component spectra together, you can produce a theoretical composite 
spectrum that is the sum of the two component spectra. This theoretical composite 
spectrum can be compared with an unknown mixture spectrum in a quantitative analysis.

Tips on adding spectra

• Use the Factor setting to scale the reference spectrum up or down before adding it to the 
sample spectrum.

• If only one of the spectra contains data points in a spectral region, the Y value of the other 
spectrum is considered to be zero in that region when the spectra are added.
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Multiply One Spectrum by Another (A*B)

Use Multiply to multiply two spectra. Most people use divide rather than multiply for most 
applications. But multiplying spectra can be useful for reprocessing a spectrum with a 
different background. For example, if you measure a sample that is adhered to a matrix, you 
can acquire a single beam spectrum of just the matrix and use that spectrum to cancel out the 
original background and replace it with the new one. Here is the equation:

S * B1/B2

Where:

S= sample spectrum (processed with original background)
B1 = original background
B2 = new background

Divide One Spectrum by Another (A/B)

Use Divide to divide one spectrum by another. Dividing spectra can be useful for reprocessing 
a spectrum with a different background. For example, if you measure a sample that is adhered 
to a matrix, you can acquire a single beam spectrum of just the matrix and use that spectrum 
to cancel out the original background and replace it with the new one. Here is the equation:

S / (B2/B1)

Where:

S= sample spectrum (processed with original background)
B1 = original background
B2 = new background

Tips on dividing spectra

• Data points that have zero absorbance values in the original sample spectrum will produce 
very strong absorbance values in the resulting spectrum.

Using Spectral Math with Data Security

When “Require reason for change for Spectral Math” is enabled in the Thermo Scientific 
Security Suite, Spectral Math requires a change reason and signature before the results can be 
saved, and the following change event is recorded in the audit log:

• Date and time
• Operation performed: subtract, add, multiply, divide
• Sample spectrum title
• Reference spectrum title
• Factor
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4

Analyze Data

Use the analysis tools in OMNIC Paradigm software to identity unknown samples and to 
verify the components of your sample. 

This section includes the following:

Contents

• Manage Spectral Libraries

Learn to view, select, and create spectral libraries to use in your analyses.

• Identify an Unknown Sample with ATR

This tutorial provides detailed instructions on using OMNIC Paradigm software to 
identify and unknown sample using the Attenuated Total Reflection (ATR) sampling 
technique.

• Identify an Unknown Sample with Transmission

This tutorial provides detailed instructions on using OMNIC Paradigm software to 
identify an unknown sample using the infrared transmission.
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Manage Spectral Libraries
Libraries contain lists of compounds and related information and can be purchased or created 
from your own data. When you perform a correlation or multi-component search, the 
analysis compares your sample spectrum to compounds stored in the libraries you specify in 
your search settings.

Use the library manager to view information about your libraries and stored compounds and 
to create or delete libraries.

Create a New Library

Create a new library to manage your spectral data and to search against your own measured 
data.

 To create a new library in the desktop interface

1. From the menu bar, select Identify > New Library.

2. In the New Library view, enter a name for the library and add any optional fields.

Optional fields are used when you add spectra to a library. For example, Figure 2 shows a 
library with two optional fields. When adding spectra to My New Library, users can 
provide a batch number and compound class.

Figure 1. Name your library and customize optional fields in the New Library view.

3. Click Save to create the new library.

Your new library is listed in the Libraries column of the library manager.
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 To create a new library in the touchscreen interface

1. From the home screen, open the menu [ ] and select Library Manager.Open the 
menu and select New Library.

2. In the New Library view, enter a name for the library and add any optional fields.

Optional fields are used when you add spectra to a library. For example, Figure 2 shows a 
library with two optional fields. When adding spectra to My New Library, users can 
provide a batch number and compound class.

Figure 2. Name your library and customize optional fields in the New Library view.

3. Touch Save to save your new library.

Add Spectra to a Library

Add spectra to a library to use your own sample data in other Search analyses.

 To add spectra to a library in the desktop interface

1. In the spectral view, select the spectrum you want to add to a library.

2. From the menu bar, select Identify > Add to Library to open the Add to Library view.

3. Select the library you want to add the spectrum to from the list of libraries.

4. Make any adjustments to the spectrum information and set a name for the compound. 
The default name will be the measurement name used when the sample was measured.

5. Click Save. Your spectrum is now available in the library, and you can view it in the 
library manager.

 To add spectra to a library in the touchscreen interface

1. In the spectral view, select the spectrum to add to a library.
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2. Select Add to Library from the menu.

3. In the Add to Library view, select a library from the Libraries column.

4. Name the compound, specify any optional fields and touch Save. The spectrum will now 
be available in your selected library.

Extract Spectra from Libraries

Extract spectra from libraries to use them as references in your analyses or workflows. 
Extracted spectra are stored with your measurements in the database, but cannot be renamed, 
tagged, or exported.

 To extract a spectrum from a library

1. Navigate to Library Manager.

2. Select a compound to extract.

3. In the toolbar, select Extract. A message confirms that the spectrum has been extracted 
successfully. View your measurements to find the extracted spectrum.

Delete Libraries and Compounds

Libraries and compounds in libraries can be deleted only in the desktop interface.

When you delete a compound, that compound is no longer used in search analyses and is 
crossed out in the list of compounds. The index position of other compounds in the library is 
maintained.

You can delete or edit only the libraries that you have created. Commercial libraries and their 
compounds cannot be deleted.

 To delete a compound from a library

1. In the Library Manager, navigate to the compound you want to delete.

2. Right-click the compound and select Delete. In the dialog box, click Yes to confirm.

 To delete a library

1. In the Library Manager, select the library to be deleted.

2. Click Delete in the toolbar, then click Yes to confirm.

CAUTION  Deleted libraries and compounds cannot be recovered.
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Identify an Unknown Sample with ATR
Your FTIR spectrometer and OMNIC Paradigm software can help you determine what’s in 
an unknown sample. This article demonstrates how to measure and analyze a sample using 
the Attenuated Total Reflection, or ATR, sampling technique. It is a common and “mess-free” 
technique for acquiring FTIR data from a sample material. This article includes a number of 
examples to help you build confidence in interpreting your analysis results.

You will learn how to:

• Prepare the ATR accessory

• Set up and run the analysis, and

• Evaluate and confirm the results

Follow these instructions to measure and analyze an unknown pure sample using the ATR 
sampling technique.

Prepare the ATR Accessory

To begin, make sure your ATR accessory is inserted in the spectrometer sample compartment 
and that it has an appropriate crystal installed. Each crystal material provides some kind of 
sampling advantage such as a wider spectral range, a higher energy throughput, or more 
durability. The correct choice depends on what crystals are available, which one works best 
with your sample material, and which one produces the needed information. See the 
information that came with your ATR accessory for more information.
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Here is the Thermo Scientific™ Everest ATR accessory with a diamond crystal installed in our 
Nicolet™ Summit FTIR spectrometer.

Make sure the crystal is clean so the spectrometer can take an accurate background 
measurement when it’s ready. To clean the crystal, dab it with a soft cloth. If the crystal 
requires more rigorous cleaning, check the user guide that came with your ATR accessory. The 
guide should list appropriate cleaning solvents for each crystal type.

Set Up the Analysis

The next step is to set up the OMNIC Paradigm software. After you open the software, you 
see the dashboard in the main window. The important measurement settings are at the top.

First, make sure the Sampling Accessory readout shows the installed accessory. If it doesn’t, 
reseat the accessory. Notice that the factory presets for that accessory appear under “Settings.”

Then enter a measurement name, or you can leave the suggested name, which is the exact date 
and time of the measurement.
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Next make sure the Analysis Type is set to Search. This performs a point-by-point comparison 
of the sample spectrum against FTIR library spectra. The quality of the output depends on 
the source and quality of the spectra in the selected libraries.

Finally, check the acquisition settings (sample scans, resolution and final format). The settings 
shown above are all good starting values for this analysis.

It’s important to note that the quality of the sample data you acquire will affect the analysis 
results. For example, speeding up the analysis by measuring fewer scans, or decreasing the 
resolution could lead to a less certain analysis result.

Consider Your Spectral Libraries

All existing spectral libraries are selected automatically by default. Choose Search Setup in the 
Identify menu to view or change your library selections.

For this demonstration, we are using the free libraries provided with OMNIC Paradigm 
software.

Choose Cancel to close the Search Setup window.

You can also use the Library Manager in the same menu to easily create a spectral library. Any 
libraries you create should be from pure materials that represent what you expect to find in 
your unknown samples.
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The library spectra are normally the same quality or higher quality than the sample spectrum. 
It is also helpful if they are acquired using the same sampling technique (ATR in this case). If 
your library spectra were acquired using the transmission technique, OMNIC Paradigm 
software has a correction that can be applied to the sample spectrum to improve the results. 
You’ll learn more about that later in this article.

There is no need to perform conversions such as final format, resolution or spectral range on 
the sample data before performing a search—the software does that for you.

Measure and Analyze the Sample

To start the analysis, click Preview and Measure Sample.

The analysis starts with a background measurement. The only requirement for an ATR 
background is to make sure the crystal is clean. The background spectrum is used to eliminate 
any signals in the sample data that are due to the spectrometer, the ATR crystal, or the 
background environment.
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The software shows a preview of the current background spectrum in the spectral pane. The 
background shape shown below is typical for a diamond crystal.

Click Start Background Measurement.

When the background measurement is completed, its image appears in the results panel and 
in the spectral pane.
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If your sample is a liquid, raise the pressure tower and rotate it out of the way. Use a clean 
pipette to place a single drop on the crystal. Keep in mind that crystal types vary in size and 
some may require more sample. Use just enough sample to cover the crystal completely.

Figure 1. Measure a liquid with ATR

For a solid sample, rotate the knob on the pressure tower counterclockwise to raise the arm. 
Then place the sample on the crystal and rotate the knob clockwise to lower the arm. 
Continue to rotate the knob until clicks. For this demonstration, we are measuring a plastic 
bag.

Figure 2. Measure a solid with ATR

The pressure tower should not be 
used when analyzing a liquid sample
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Once a sample is in place, click Preview Sample to preview the sample data in the spectral 
pane. If the peaks in the preview spectrum are very small, use a more concentrated liquid 
sample. If you are measuring a solid, reposition the sample on the ATR crystal and reapply 
pressure.

If the spectrum has no sample peaks, check that the sample material absorbs energy in the 
infrared region of the light spectrum. If you observe extra peaks in the spectrum, make sure 
the crystal is clean.

When you are ready to continue, choose Start Sample Measurement (see the previous image) 
and wait for the progress bar to complete. The software quickly compares the sample 
spectrum to the selected library spectra and shows you the results.
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What’s in My Sample?

The spectral pane shows the sample spectrum along with the best matched spectrum from the 
selected libraries. The two spectra are overlaid with the same Y-axis scale so you can compare 
the results visually. (If the spectra are very similar, as in this case, there are other views that will 
highlight the differences. We’ll talk more about that later.) The results panel shows a list of the 
5 best matched spectra, along with their match values.

Figure 3. Sample and top search result displayed together using the same Y-axis scale

1. Sample spectrum (red)
2. Best match (yellow)
3. Results panel
4. Stack button
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The match values tell you how well each library spectrum matches the unknown sample. The 
closer this value is to 100, the better the match.

In this example, the top match has a match value that is above 90, which indicates a good 
match. The match value for the next spectrum in the list is well below that.

Figure 4. Match values showing a clear best match

If we look at the overlaid spectra in the spectral pane, the positions of the main peaks line up 
along the X-axis, and they differ only in their peak heights.

Figure 5. Overlaid spectra showing a clear match
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Click the Stack button to see the two spectra scaled to fill each Y-axis. Again, the spectra are 
well matched except for the slightly raised baseline in the sample spectrum’s low frequency 
region. As a result, we can conclude that the sample is polyethylene and the analysis is 
complete.

Figure 6. Stacked spectra showing a minor difference in the low frequency region

To get more information about a spectrum in the match list, including the library it came 
from and its identification number, click the spectrum’s grey arrow in the results panel.

Figure 7. Information button for a library spectrum
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What if there isn’t a clear (single) match?

If the analysis results show several matches that all have similar match values, as in this 
example, Shift + click the three matches in the results panel to add all three spectra to the 
spectral pane.

Figure 8. Stacked spectra showing several similar matches
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How can I improve my analysis results?

If no clear match appears, there are a number of options to consider that may improve your 
results. (Some setting adjustments will require a new background measurement.)

Figure 9. Search results with changeable measurement settings displayed

For starters, you can return to the dashboard and adjust the Resolution setting for the 
unknown sample. For example, you can acquire the spectrum at a higher resolution by using a 
lower Resolution setting. If the sample peaks are sharper or more numerous, you may get a 
better analysis result.

You can also acquire more scans (see image above) to reduce spectral noise, which can also 
affect the results. Then restart the analysis by choosing Identify (menu) > Correlation Search 
or click the Search button on the toolbar.

If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline 
Correction (Process menu) to your sample spectrum and then restart the analysis.

If you need to search against transmission spectra, try using the Advanced ATR Correction 
(Process menu) and then repeat the analysis. This correction adjusts an ATR spectrum so that 
it looks more like a transmission spectrum, which can improve the results.
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How to Specify the Spectral Region for the Analysis

If your sample spectrum has a peak that is so large it is off the Y-axis scale, you may want to 
exclude that peak from your analysis. Here is an example:

Figure 10. Example of a totally absorbing peak
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These “flat topped” peaks are referred to as “totally absorbing” and can contain excessive 
spectral noise, which affects the analysis results. To exclude a totally absorbing peak, 
right-click the sample spectrum and choose Add Region. Use the vertical bars to select a 
region that excludes the peak in question and then rerun the analysis.

Figure 11. Using Add Region to exclude a peak from the search
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Identify an Unknown Sample with Transmission
Your FTIR spectrometer and Thermo Scientific™ OMNIC Paradigm software can help you 
identify the chemical composition of an unknown sample. This article demonstrates how to 
measure and analyze a sample using infrared transmission. By “transmission” we mean that the 
infrared beam passes directly through the sample. Transmission is a common technique for 
acquiring FTIR data. This article includes a number of examples to help you build confidence 
in interpreting your analysis results.

You will learn how to:

• Prepare the transmission accessory

• Set up and run the analysis, and

• Evaluate and confirm the results

Prepare the Transmission Accessory

To begin, make sure your transmission accessory or sample holder is inserted in the 
spectrometer sample compartment. Here is the Thermo Scientific™ iD1 Transmission 
Accessory in our Nicolet™ Summit FTIR Spectrometer.
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Remove any sample from your accessory or sample holder so the spectrometer can take an 
accurate background measurement when it’s ready. The iD1 accessory cover can be open or 
closed. (If your transmission accessory is purged with dry air or nitrogen, keep the cover 
closed unless you are adding or removing a sample.)

Set Up the Analysis

The next step is to set up the OMNIC Paradigm software. After you open the software, you 
see the dashboard in the main window. The important measurement settings are at the top.

First, make sure the Sampling Accessory readout shows the installed accessory. If it doesn’t, 
reseat the accessory. Notice that the factory presets for that accessory appear under “Settings.”

Then enter a measurement name, or you can leave the suggested name, which is the exact date 
and time of the measurement.

Next make sure the Analysis Type is set to Search.

This performs a point-by-point comparison of the sample spectrum against FTIR library 
spectra. The quality of the output depends on the source and quality of the spectra in the 
selected libraries.

Finally, check the acquisition settings (sample scans, resolution and final format). The settings 
shown above are all good starting values for this analysis.

It’s important to note that the quality of the sample data you acquire will affect the analysis 
results. For example, speeding up the analysis by measuring fewer scans, or decreasing the 
resolution could lead to a less certain analysis result.
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Consider Your Spectral Libraries

All existing spectral libraries are selected automatically by default. Choose Search Setup in the 
Identify menu to view or change your library selections. For this demonstration, we are using 
the free libraries provided with OMNIC Paradigm software and the Nicolet Summit Pro 
spectrometer.

Choose Cancel to close the Search Setup window.

You can also use the Library Manager in the same menu to easily create a spectral library. Any 
libraries you create should be from pure materials that represent what you expect to find in 
your unknown samples.

The library spectra are normally the same quality or higher quality than the sample spectrum. 
It is also helpful if they are acquired using the same sampling technique (transmission in this 
case). There is no need to perform conversions such as final format, resolution or spectral 
range on the sample data before performing a search—the software does that for you.
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Measure and Analyze the Sample

To start the analysis, click Preview and Measure Sample.

The analysis starts with a background measurement. The only requirement for a transmission 
background is to remove any sample from the path of the infrared beam. The background 
spectrum is used to eliminate any signals in the sample data that are due to the spectrometer, 
your transmission accessory or sample holder, or the background environment.

The software shows a preview of the current background spectrum in the spectral pane. The 
examples below show typical background spectra for transmission analysis using a 
transmission accessory that has not been purged with dry air or nitrogen, and one that has 
been purged.

Figure 12. Background spectrum from a transmission accessory that has not been purged
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Figure 13. Background spectrum from a transmission accessory that has been purged

Click Start Background Measurement.

When the background measurement is completed, its image appears in the results panel and 
in the spectral pane.
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To install a mounted film sample, open the cover for the transmission accessory and slide your 
sample or sample holder into a slot that best fits the sample or sample holder width. If your 
sample or holder allows it, choose a slot that is close to the beam’s focal point (for the iD1 
accessory, this is roughly in the center of the sample compartment). For this demonstration, 
we are measuring a plastic film mounted on a sample card.

Figure 14. iD1 Transmission Accessory beam focal point

Once a sample is in place, click Preview Sample to preview the sample data in the spectral 
pane.
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If the peaks in the preview spectrum are very small, try using a thicker sample. If the spectrum 
has no sample peaks, check that the sample material transmits energy in the infrared 
spectrum.

When you are ready to continue, choose Start Sample Measurement (see the previous image) 
and wait for the progress bar to complete. The software quickly compares the sample 
spectrum to the selected library spectra and shows you the results.

What’s in My Sample?

The spectral pane shows the sample spectrum along with the best matched spectrum from the 
selected libraries. The two spectra are overlaid with the same Y-axis scale so you can compare 
the results visually. (If the spectra are very similar, as in this case, there are other views that will 
highlight the differences. We’ll talk more about that later.) The results panel shows a list of the 
5 best matched spectra, along with their match values.

Figure 15. Sample and top search result displayed together using the same Y-axis scale

The match values tell you how well each library spectrum matches the unknown sample. The 
closer this value is to 100, the better the match.

1. Sample spectrum (red)
2. Best match (blue)
3. Results panel
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In this example, the top match has a match value that is above 85, which indicates a good 
match. The match value for the next spectrum in the list is well below that.

Figure 16. Match values showing a clear match

If we look at the overlaid spectra in the spectral pane, the positions of the main peaks line up 
along the X-axis, and they differ only in their peak heights.

Figure 17. Overlaid spectra showing a clear match
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Click the Stack button to see the two spectra scaled to fill each Y-axis. Again, the spectra are 
well matched except for the slightly raised baseline in the sample spectrum’s low frequency 
region. As a result, we can conclude that the sample is polyethylene and the analysis is 
complete.

Figure 18. Stacked spectra showing a clear match

To get more information about a spectrum in the match list, including the library it came 
from and its identification number, click the spectrum’s grey arrow in the results panel.

Figure 19. Information button for a library spectrum
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What if there isn’t a clear (single) match?

If the analysis results show several matches that all have similar match values, as in this 
example, Shift + click the three matches in the results panel to add all three spectra to the 
spectral pane for a detailed comparison.

Figure 20. Stacked spectra showing several similar matches

How can I improve my analysis results?

If no clear match appears, there are a number of options to consider that may improve your 
results. (Some setting adjustments will require a new background measurement.)

For starters, you can return to the dashboard and adjust the Resolution setting for the 
unknown sample. For example, you can acquire the spectrum at a higher resolution by using a 
lower Resolution setting. If the sample peaks are sharper or more numerous, you may get a 
better analysis result. You can also acquire more scans to reduce spectral noise, which can also 
affect the results. 

If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline 
Correction (Process menu) to your sample spectrum. Then restart the analysis by choosing 
Identify (menu) > Correlation Search, or click the Search button on the toolbar.



Identify an Unknown Sample with Transmission

Thermo Scientific OMNIC Paradigm User Guide 65

How to Specify the Spectral Region for the Analysis

If your sample spectrum has a peak that is so large it is off the Y-axis scale, you may want to 
exclude that peak from your analysis. Here is an example:

Figure 21. Example of a totally absorbing peak

These “flat topped” peaks are referred to as “totally absorbing” and can contain excessive 
spectral noise, which affects the analysis results.
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To exclude a totally absorbing peak, choose Identify (menu) > Search Setup and use the tools 
to select the regions to search.

First, clear the “Use Full Spectral Range” check box to enable the region tools.

Figure 22. Tools for selecting the regions to search

Then position the vertical bars to select the first region to search.
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To add a search region, click the Add button and use the second set of vertical bars to select 
the next region. Here we used the first set of vertical bars to select the region to the left of the 
fully-absorbing peak. And then we added a region and used the second set of vertical bars to 
select the region to the right of the fully-absorbing peak.

When you are finished selecting regions, click Save to return to the Dashboard view, and then 
click the Search button on the toolbar to re-run the search.
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Verify Sample Composition with QCheck
Verify your sample quality with a QCheck analysis. With QCheck, your sample is compared 
to a known reference, and the results report a correlation value between your sample and the 
reference, giving you quick verification that your sample meets your specifications. 

This guide walks you through an example QCheck analysis. 

Prerequisites

This guide assumes that you have already set up your instrument and sampling accessory. For 
instructions on installing a sampling accessory, see the documentation that came with your 
instrument.

You will also need at least one spectrum to use as a reference. You can specify any spectrum in 
your database as the reference spectrum. To use a spectrum from a library, first extract the 
spectrum from the library so that it is available in the database. For details, see Extract a 
Spectrum from a Library

Performing a QCheck Analysis

Running a QCheck analysis requires you to set up your analysis and measurement settings, 
measure the background, measure your sample, and interpret your results. Finally, when your 
analysis is complete, you can create and save a report.

 To verify your sample composition with QCheck

1. Set up the analysis.

Before measuring your sample, review your analysis settings.

a. Navigate to Identify > QCheck Setup.

b. Review the QCheck Setup options.
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Setting Description

High Sensitivity Select high sensitivity for more exact results between a 
sample that is very similar to the reference. You may want 
to de-select high sensitivity if you are measuring samples 
with some natural variation.

Pass/fail threshold Set a threshold for pass or failure. Enter an integer between 
0 and 100. 

A correlation value of 100 indicates a perfect match.

If you de-select this option, all results will show Pass.

Maximum spectra in 
QCheck results

Sets the number of results shown in the results panel. For 
example, if you set the value to 2, only the two best 
matches will be shown in the results panel.

Prompt for reference Select to choose a reference during the measurement. 
De-select to specify one or more reference spectra in 
advance. If you are planning to compare several samples to 
the same references, it is convenient to set them in advance 
to avoid having to keep selecting the same reference every 
time you measure a sample.

Blank diamond ATR 
region (2200 - 1955)

Select to exclude data in the region from 2200 
wavenumbers to 1955 wavenumbers, where diamond ATR 
crystals absorb radiation.
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c. To save your settings and return to the dashboard, click Save.

d. On the dashboard, review your measurement settings, and confirm that the listed 
sampling accessory matches the accessory you are using.

e. From the Analysis Type list, select QCheck.

Once you are satisfied with your measurement and analysis settings, you are ready to 
measure the background.

2. Measure the background.

Before measuring your sample, you need to have a current measurement of the 
background.

The background spectrum is used to eliminate any signals in the sample data that are due 
to the spectrometer, the sampling accessory, or the background environment.

a. Click Preview and Measure Background.

b. Click Start Background Measurement. When the background measurement is 
complete, the spectrum is added to the results panel.

3. Measure your sample.

a. Load your sample. For instructions on loading a sample, see the documentation that 
came with your instrument or sampling accessory.

b. Click Preview Sample. The Sample Preview displays a live preview of your sample 
spectrum. The preview gives you the opportunity to correct any potential issues 
before measuring the sample. 

c. When you are ready to continue, click Start Sample Measurement.

If Prompt for Reference is selected in your analysis settings, the Select Reference 
Spectrum dialog opens after the measurement is complete.

d. Select one or more reference spectra to use in the analysis and click OK. 

Hold Ctrl and click to add a spectrum to your selection. 

Hold Shift and click to add a group of spectra to the selection.

Blank CO2 region 
(2390 - 2240)

Select to exclude data in the region from 2390 
wavenumbers to 2240 wavenumbers, where carbon 
dioxide absorbs radiation.

Use full spectral range Select to use the full range in the analysis.

De-select to specify only a limited range to use for the 
analysis.

Setting Description
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4. Interpret your results.

When the measurement and analysis are complete, your results are displayed in the results 
panel. Hover over the gray arrow for additional details.

5. Create a report

When you are finished with your analysis, create a report to export your results to 
Microsoft™ Word™, PowerPoint™ or Excel™ or to print or save your results. 

a. Navigate to File > Create Report.

b. Give your report a title.

c. Select a format from the Format list and choose the Quantify template. A preview of 
the report is shown in the right panel.

d. Click Create.

Improving Your Results

If your correlation value is lower than expected, there are several options to consider that may 
improve your results. 

• Return to the dashboard and adjust the Resolution settings for your measurement. For 
example, you can measure the sample at a higher resolution by selecting a smaller value, 
such as 1 or 2. If the sample peaks are sharper or more numerous, you may get a more 
accurate analysis result.

• Increase the number of scans in your measurement, which may reduce spectral noise.

• If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline 
Correction to your sample and then restart the analysis from the Identify menu.
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• Exclude selected regions from the analysis. If your sample spectrum has a peak that is so 
large it is off the Y-axis scale, you may want to exclude that peak from your analysis. These 
“flat topped” peaks are referred to as “totally absorbing” and may affect the analysis 
results. Open QCheck Setup, de-select Use Full Spectral Range, and select ranges that 
exclude the sample spectrum’s totally absorbing peak. Then, rerun the QCheck analysis.

Extract a Spectrum from a Library

Extract a spectrum from a library to use it as a reference in a QCheck analysis. Spectra 
extracted from commercial libraries can be used for analysis, but cannot be renamed, tagged, 
or exported.

 To extract a spectrum from a library

1. From the dashboard of the desktop interface of OMNIC Paradigm software, navigate to 
Identify > Library Manager.

2. Select a compound to extract.

3. Click Extract. A confirmation message states that the spectrum was successfully extracted. 

Next Steps

In this guide, you set up and ran a QCheck analysis to verify that your sample matched a 
known reference within a pre-set threshold. 

Next, see Create and Run Your First Workflow for a guided tutorial on using workflows to 
create routine, repeatable procedures.
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Quantify Sample Composition
Find the concentrations of components in your sample using a Quantify analysis. A Quantify 
analysis uses a previously created quantitative analysis method and reports the concentration 
of components in the sample or other kind of information, such as peak height or match 
value. 

This guide walks you through setting up and running a Quantify analysis using the desktop 
interface of OMNIC Paradigm software.

Prerequisites

This guide assumes that you have already set up your instrument and sampling accessory. For 
instructions on installing a sampling accessory, see the documentation that came with your 
instrument.

You will also need a valid quantification method saved as a QNT file. The quantitative 
analysis method must be calibrated using Thermo Scientific TQ Analyst software. See the 
documentation that came with that software for information on calibrating quantitative 
analysis methods.

Performing a Quantify Analysis

Running a Quantify analysis requires you to import a QNT file, review your measurement 
settings, measure the background, and finally measure your sample. When analysis is 
complete, you can create a report to save or share your results.

 To perform a Quantify analysis

1. Set up the analysis.

a. On the dashboard of the desktop interface of OMNIC Paradigm software, confirm 
that the settings display your sampling accessory.

b. Navigate to Identify > Quantify Setup and browse to the QNT file you would like 
to use in the analysis.

The file explorer displays additional information about the QNT file that you have 
selected, such as the method title, method type, and whether the method has been 
calibrated.

c. To import the method, click Open.
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d. In the Analysis type list, select Quantify. A symbol indicates that you have 
imported a valid QNT file. A red circle with an X [ ] indicates that a valid method 
has not been imported. 

When selecting a QNT file, the file explorer displays additional information to help 
you make a selection, including the method title and type and whether the method 
has been calibrated. Only methods that have been calibrated with TQ Analyst 
software are valid.

2. Measure the background.

Before measuring your sample, you need to have a current measurement of the 
background.

The background spectrum is used to eliminate any signals in the sample data that are due 
to the spectrometer, the sampling accessory, or the background environment.

a. Click Preview and Measure Background.

b. Click Start Background Measurement. When the background measurement is 
complete, the spectrum is added to the results panel.

3. Measure the sample.

a. Load your sample. For instructions on loading a sample, see the documentation that 
came with your instrument or sampling accessory.

b. Click Preview Sample. The Sample Preview displays a live preview of your sample 
spectrum. The preview gives you the opportunity to correct any potential issues 
before measuring the sample. 

c. When you are ready to continue, click Start Sample Measurement.
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4. Interpret your results.

When the sample measurement is complete, the Quantify dialog box displays results of 
the analysis. The results shown depend on the settings in the quantitative analysis method 
used in the analysis. The results shown below show a measurement only result indicating 
a passing value.

After clicking OK to close the Quantify dialog box, you can view the analysis results by 
clicking the information icon [ ] next to the spectrum in the results panel. In the 
Spectrum Information dialog, navigate to the History tab and see the Quantify Results 
section.

5. Create a report

When you are finished with your analysis, create a report to export your results to 
Microsoft™ Word™, PowerPoint™ or Excel™ or to print or save your results. 

a. Navigate to File > Create Report.

b. Give your report a title.

c. Select a format from the Format list and choose the Quantify template. A preview of 
the report is shown in the right panel.

d. Click Create.

Improving Your Results

If your results are unclear or problematic, there are several options to consider that may 
improve your data. 
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• Return to the dashboard and adjust the Resolution settings for your measurement. For 
example, you can measure the sample at a higher resolution by selecting a smaller value, 
such as 1 or 2. If the sample peaks are sharper or more numerous, you may get a more 
accurate analysis result.

• Increase the number of scans in your measurement, which may reduce spectral noise.

• If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline 
Correction to your sample and then restart the analysis from the Identify menu.

Next Steps

In this guide, you set up and ran a Quantify analysis.

Next, see Create and Run Your First Workflow for a guided tutorial on using workflows to 
create routine, repeatable procedures.
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5

Use Workflows

Use workflows to automate your tasks, ensuring that your analysis and processing will be 
carried out in exactly the same way each time.

This section includes the following:

Contents

• About Workflows

Provides an overview of using workflows to automate important procedures and frequent 
tasks

• Create and Run Your First Workflow

This tutorial walks you through the process of creating and running your first workflow

• Workflow Tiles Reference

This reference describes available workflow tiles and their settings
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About Workflows
You can use the workflow features in OMNIC Paradigm software to automate important 
procedures and frequent tasks. A workflow is a series of software operations that can be 
initiated with the click of a button. The software operations are represented by tiles, which 
you drag and drop onto the workflow canvas in OMNIC Paradigm software. You can specify 
settings for data collection, provide instructions for operators, and define data processing, 
reporting, and archiving in advance. Once a workflow has been created, operators can use it 
repeatedly to complete the steps the same way every time.

This article provides an overview of these basic workflow features and tools:

• Workflow pane

• Play Workflow window

• Workflow editor
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Workflow Pane

The workflow pane is always available at the bottom of the OMNIC Paradigm dashboard. 
Use this space to preview and play workflows you’ve created, and to open the workflow editor 
to edit or create a new workflow.

Figure 1. Workflow Pane on the OMNIC Paradigm Dashboard

Table 1. Work with existing workflows from the workflow pane

To do this... Take this action

Select and preview a workflow Click once on the workflow name

Test or run a workflow Double-click the workflow name. This opens the 
Play Workflow window where you can step through the 
workflow tasks.

Edit, rename, duplicate, delete or 
export the selected workflow

Right-click the workflow and choose an option from the 
shortcut menu.

1. Most recent workflows (click once to preview a 
workflow; click twice to play it)
2. Right-click a workflow for more options

3. Preview of selected workflow
4. Enlarge or reduce the Workflows pane
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Play Workflow Window

Use the Play Workflow window to test or run a workflow. To open the Play Workflow 
window, double-click a workflow name in the Workflows list on the dashboard.

Figure 2. Double-click a Workflow Name to Run the Workflow

1. Selected workflow (double-click 
to open and run this workflow)
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From the Play Workflow window, use the arrow button to move to the next task in the 
workflow. The workflow will play exactly as it has been designed, with tasks and operator 
messages displayed as indicated by the workflow.

Figure 3. Play Workflow Window

To stop the workflow and return to the dashboard, click the Stop button in the Play Workflow 
window. (If the workflow doesn’t have a Stop button, click the Dashboard button on the 
toolbar to stop the workflow.)

Workflow Editor

The workflow editor contains all the tools for creating workflows, including the workflow 
menu, toolbar, tile selection bar, and canvas. To open the workflow editor, right-click a 
workflow name on the dashboard and choose Edit from the shortcut menu.

You can also open the workflow editor from the OMNIC Paradigm main window by 
choosing:

File (menu) > Workflows > Create Workflow

1. Toolbar
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The workflow canvas is where you select and set up the tasks you want the workflow to 
perform and join tasks together to create the workflow. The workflow editor opens with the 
mandatory “Workflow Start” and “Workflow End” tiles displayed on the canvas. Available 
settings for each tile in the current workflow are in the expandable sections below the canvas. 
Tools for scrolling, zooming and resetting the canvas view are at the right. A handy toolbar is 
above the canvas.

Figure 4. Workflow Editor

Each task is represented by a colorful tile in the tile selection bar. Here are some commonly 
used examples:

Tools for creating, opening, and exporting workflows are located in the Workflow submenu 
(available from the OMNIC Paradigm File menu). Example workflows, available here, are a 
good place to start, or you can create a workflow from a spectrum’s history. See “Create and 
Run Your First Workflow” for details.

1. Toolbar
2. Tile selection bar
3. Canvas
4. Tile settings

5. Tools to adjust and reset the canvas view
6. Start tile
7. End tile
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Tiles can be added, moved, copied and deleted to create the desired workflow. For more 
information, see the article titled “Edit a Workflow.”
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Create and Run Your First Workflow
This article explains a simple way to create workflows in OMNIC Paradigm software. For 
basic information about workflows and brief descriptions of the workflow features and editing 
tools, see the article titled “About Workflows” in the OMNIC Paradigm online help.

There are several ways to create workflows. Some approaches may work better than the others, 
depending on the steps you are trying to automate and how you want to start. For example, 
you can create a new workflow by:

• building a workflow from scratch

• editing a workflow that someone gave you

• duplicating an example workflow provided with the software

• performing the measurement tasks you want to automate and letting the software create 
the workflow from the spectrum’s history information

This article shows how the software can create a workflow automatically based on the history 
of an acquired spectrum. It also demonstrates how to:

– run a workflow from the workflow editor or dashboard

– identify workflow generated spectra

– edit a workflow by adding tiles, and

– fix a common workflow error

The last section provides useful tips for creating and editing workflows.

Note  The software operations to create workflows are available only in the desktop 
version of OMNIC Paradigm software (not the touchscreen version).
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Create a Workflow

 To create a new workflow from an acquired spectrum

1. From the OMNIC Paradigm dashboard, acquire a spectrum of a sample material.

It doesn’t matter what kind of material or sampling technique you use. If the software 
requires a new background measurement, go ahead and do that first. When the sample 
measurement is completed, the sample spectrum is displayed in the spectral view.

Here is our example spectrum (plastic bag measured with an Attenuated Total 
Reflectance, or ATR, accessory) displayed in the spectral view:

2. Make sure the spectrum is selected in the spectral pane and then perform any processing 
or analysis steps you like (for example, subtraction, baseline correction, correlation search, 
etc.).
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Here is our example spectrum after applying Advanced ATR Correction and Automatic 
Baseline Correction and then performing a Correlation Search.

3. Give your spectrum a descriptive name (the software will use this name for the created 
workflow).

a. Right click the image of the original spectrum in the results panel and choose 
Rename Spectrum.

b. Replace the default name with a descriptive name for your workflow and choose OK. 
Here is our renamed example spectrum.
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4. Once you have completed your processing and analysis steps, click the History button in 
the results panel.

The history panel shows all the tasks performed on the selected spectrum in the order in 
which they were performed. Here is the history information for our example spectrum.

5. At the bottom of the history panel, click Create Workflow.
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The software creates a workflow that includes all of the steps you just performed. The 
workflow is displayed in the workflow editor. Each performed task is represented by a 
colorful tile. Depending on which steps you performed, your workflow may look 
different from our example below:

6. To save your new workflow, click the Save button on the toolbar.

7. To run the workflow, click the Run button on the toolbar.

The workflow performs the same tasks you completed manually in exactly the same 
sequence. In our case, we measured a spectrum, performed an Advanced ATR Correction, 
corrected the spectral baseline, and performed a correlation search.

When the workflow is done, the software returns to the Workflow Editor.
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8. Click the Dashboard button on the toolbar to see your newly created workflow in the 
Workflows list.

The workflow is named automatically based on the name of the spectrum used to create 
it. Here is our newly created example workflow in the Workflows list and a preview of the 
workflow in the preview box.

9. The workflow-generated spectra appear in the Measurements list.

Our example workflow created four spectra, the measured background spectrum, the 
measured sample spectrum, the ATR corrected sample spectrum, and the ATR and 
baseline corrected sample spectrum with the search results. The workflow-generated 
spectra are named with the Tile Name properties of their associated workflow tiles.
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Add Tiles to a Workflow

This section demonstrates how to use the workflow editing tools to add tiles to your 
auto-generated workflows.

1. From the dashboard, right-click the workflow name and choose Edit.

The workflow opens in the workflow editor.



Create and Run Your First Workflow

Thermo Scientific OMNIC Paradigm User Guide 92

2. Add a Tag Spectrum tile to the workflow.

Workflow-generated spectra are saved in the OMNIC Paradigm database along with any 
data acquired manually. Let’s tag the workflow spectra to associate them with our 
workflow. This makes it easy to open and view them later.

a. In the workflow editor, drag the Tag Spectrum tile from the selection 
bar to the canvas so that your mouse cursor hovers over the grey arrow  between 
the Measurement and ATR Correction tiles.

The grey arrow changes to a plus sign.
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b. Release the mouse button.

The tile is added to that location in the workflow and its settings box is opened below 
the canvas.

c. In the Tag Settings enter a base name for your workflow-generated spectra, such as 
“ATR Search Spectra”, make sure Select Spectrum is set to your measured spectrum 
(“Measurement - Sample”), and choose OK.

The Tag Spectrum tile will automatically add the “ATR Search Spectra” tag to each 
spectrum generated by the workflow. We’ll explain how to search for those spectra 
later.

Now let’s explore what happens when we add a tile that flags an error.
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3. Add a Report Template tile to the workflow.

a. In the workflow editor, use the mouse to hover over the grey arrow between the 
Search and End tiles (arrow changes to a plus (+) sign) and then click the mouse 
button. The software opens the Add Tile box. (This is another easy way to add tiles.)

b. In the Add Tile box, select the Template Report and choose OK.

The tile is added to that location in the workflow and its settings box is opened below 
the canvas.
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Notice that the Report Template tile has a red border, which indicates the workflow 
won’t run successfully right now. If we view the Report Template settings, the boxes 
are all blank.

To fix the problem, we need to specify a template for the report and which results to 
include.

c. Set Template Type to your preferred report style (we are using the Search Results 
template), set Search Results To Display to your workflow’s output (“Search Result” 
in our example) and choose OK.

Notice that the red border is no longer there.

4. To save the updated workflow, click the Save button on the toolbar.

5. To run the workflow, click the Run button on the toolbar.

The workflow runs through all the steps and then displays the final report.
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Click the arrow button to end the workflow.

6. Click the Dashboard button on the toolbar to return to the dashboard.

7. If you select the workflow in the Workflows list, the preview has been updated.
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8. If you enter your tag in the Search box, the software shows you the workflow-generated 
spectra in the Measurements list.

To view the spectra in the spectral pane, use Shift + Click to select all four in the 
Measurements list, then right-click and choose “Open Selected Measurements.”

9. To see the workflow-generated report, click this arrow button and select “Reports.”

Tips on Creating Workflows

Before you head off to create more workflows, read through these answers to common 
questions about workflows and tips for solving any problems that may occur.

• Is the order in which the tiles appear in the workflow important? Yes, the order of the 
tiles is important. Each workflow tile builds on the previous tiles, and all the tiles are 
interconnected by their input requirements and their output results. For example, if you 
add a Measure tile, it creates an output result (a spectrum), which can only be accessed by 
tiles positioned after the Measure tile in the workflow. If you want to baseline correct the 
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acquired spectrum, you would need to add a Baseline tile after the Measure tile, and then 
set the Baseline input to the Measurement output (i.e., the spectrum). Otherwise, the 
Baseline tile will have a red border, indicating it contains options that must be set before 
the workflow will run. If you see a tile that has a red border, use the mouse to hover over 
that tile for help finding the source of the problem.

• Do I need to add a background measurement to my workflow? Not unless you want 
the workflow to perform an operation only on the background spectrum. If you only 
need a background spectrum in order to process your measured sample data, then you 
just need to add a Measure tile to the workflow and use the Measure tile settings to define 
the background measurement.

• Can I change the titles of the workflow tiles? Each workflow tile has a setting that 
specifies the tile name. (Double-click the tile in the workflow editor to open its associated 
settings.) The Tile Name setting can be used to add detail to your workflow. This can 
help the workflow developer keep things organized, especially when creating workflows 
that contain multiple paths or loops, or multiple tiles of the same type (several Measure 
tiles, for example, in the same workflow).

The tile names may also be used to name output files when the workflow is run. Here are 
some examples:

– Measure tile. This tile acquires background and sample spectra. When the workflow 
is run, the sample spectrum is saved with the tile name of its associated Measure tile.

– ATR Correction Tile, Process Tile, etc.. Tiles that operate on acquired spectra 
generate output spectra that are saved along with the final sample spectrum when the 
workflow is run. Each interim “processed” spectrum is saved with the tile name of the 
workflow tile that generated it.

– Report tile. This tile creates a sample report. When the workflow is run, the report is 
saved with the tile name of its associated Report tile.

• Should every workflow have an Archive tile? The answer to this question is “no.” Any 
spectra and reports generated from a workflow are saved automatically in the OMNIC 
Paradigm database, along with all the other spectra and reports that are created manually 
with the spectrometer (that is, not from a workflow). If you want to save your 
workflow-generated spectra and reports as files that can be archived or opened elsewhere 
(from your OMNIC Paradigm workstation software, for example), use an Archive tile to 
create those files automatically.
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• Why doesn’t my workflow run? Before you run a newly created workflow, ensure there 
are no tiles with a red border. Here is an example:

The workflow will not run to completion if it contains a tile with a red border.

If your workflow has a red bordered tile, use the mouse to hover over the tile for tips on 
how to solve the problem. Typically, the red border indicates the tile contains required 
options that have not been set. However, it can also mean the tile is “illegal.” For example, 
if you place a Baseline tile before a Measure tile in a workflow, the Baseline tile will have a 
red border and the workflow will contain an unresolvable error because there is no output 
spectrum to baseline correct.
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Workflow Tiles Reference
Workflow tiles are icons that represent the tasks a workflow can perform. Each tile has settings 
that define what the tile does when the workflow runs. To see a tile’s settings, add the tile to 
your workflow on the workflow canvas, then double-click the tile.

This reference of workflow tiles is organized alphabetically. Each tile description includes a 
description of available settings.

Archive 

Send data and reports to a user specified location. This location can be on your local system or 
on a network or flash drive for alternate storage.

Setting Description

Select data to 
archive

Choose from available spectra and reports created or imported during 
the workflow.

File base name The base name is prepended to the full file name.

When the file is archived, it is named according to the following 
template:

<base name>_<workflow name>.<tile name of data creation>.<variable 
name>_YYYY_MM_DD_HHMMSS_<time zone in GMT>.<file 
extension>

For example, with a base name of “example” and a workflow called 
“my workflow”, a spectrum collected on the Measure tile would be 
archived as the following:

“example_my workflow.Measure.Sample_
2019_06_25_104928_GMT-0500.spa”

File location The directory in which the file will be archived. 

Tile name Sets the name of the tile in the workflow canvas.
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ATR Correction

Corrects ATR spectra for the effects of variation in the depth of penetration and the shifting 
infrared absorption bands that occur with the ATR technique.

Setting Description

Crystal type Select the type of crystal used to measure the sample.

Angle of incidence Enter the angle of incidence that was used to measure the sample. See 
the specifications for the accessory to obtain this value. 

The Everest ATR Accessory: 45°

The default value is 45.00

Sample refractive 
index

Enter the refractive index of the sample at 1000 cm-1. Most organic 
materials range between 1.45 and 1.55 at 1000 cm-1. Materials that 
contain carbon black have higher refractive index values (1.7 or 
higher). If you do not know the refractive index of your sample 
material at 1000 cm-1, we recommend using the default value of 1.5.

Number of 
bounces

Enter the expected number of internal reflections of the infrared beam 
that occurred in the ATR crystal. See the documentation for your ATR 
accessory for information about crystal material, angle of incidence, 
and the number of bounces.

The default value is 1.00

Select spectrum ATR Correction is applied to the specified spectrum.

Tile name Sets the name of the tile in the workflow canvas.
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Decision

With a Decision tile, you can control the flow of the workflow based on criteria that you 
specify. For example, you can provide two separate paths based on whether or not a 
correlation search result had a match value above a specified threshold. 

Setting Description

Pass/Fail Select a pass/fail decision type to use a previously generated pass/fail 
result as the decision criteria. 

For example, the Peak Analysis tile can generate a pass/fail result based 
on the measurement of the peak height. For instance, you can specify 
that if the peak height is above a given value, generate a pass result, and 
if it was below that value, generate a fail result. Then, you can use the 
decision tile to continue the workflow in two separate paths, 
depending on that result.

Numeric Value Select a numeric value to be used in the decision. The value can be 
data generated in a previous workflow tile or it can be a value that the 
operator entered using the Instruction tile.

For example, you can check if the match value of a search result was 
above a specified threshold and continue the workflow based on that 
criteria.

String Value Select a string value to be used in the decision. The string can be data 
generated in a previous workflow tile or it can be text entered by the 
operator using the Instruction tile.

With a string value, you can check if the selected value is equal to or 
contains your test string. 

For example, if you select Contains and provide “Poly” as the test 
string, the decision tile will evaluate to True if the selected value is 
Polystyrene.

Spectrum Age Ccontrol the flow of the workflow depending on the age of a 
spectrum. 

For example, you can check if a background spectrum is more than 20 
minutes old before moving on to another step in the workflow and 
then measuring a new background if necessary.

Tile name Sets the name of the tile in the workflow canvas.
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Delay

Pauses the workflow for the indicated amount of time before proceeding.

End

Every workflow has at least one End tile. If your workflow includes Decision or Selection tiles, 
there may be more than one possible ending.

Export

Exports collected data to a CSV file.

Setting Description

Delay (seconds) The number of seconds that the workflow will remain paused.

Message The message is displayed to the operator during the delay. 

Tile name Sets the name of the tile in the workflow canvas.

Setting Description

End type Choose Success or Failure for a visual indication of the workflows end 
state. The end type does not affect data in the workflow. It only 
provides a visual cue to the workflow developer.

Note Use the note field to enter text for a tooltip that appears when 
hovering over the tile in the workflow canvas. This is useful for 
providing a reminder to the workflow developer. For example, if used 
with a Failure end type, the note could summarize the test that caused 
the failure. 

Tile name Sets the name of the tile in the workflow canvas.

Setting Description

Select data to 
export

Select available data that can be exported to the CSV file, such as peak 
heights or search result match values.

Append to file If selected, will append the exported data to an existing CSV file. 

To append the data to an existing file, enter the name of the file in the 
File Name field. If the file doesn’t exist, a new file will be created with 
the name you entered.

File name (only available if Append to File is selected)

Enter the name of the file that the data will be appended to. If the file 
does not already exist, a new file will be created.
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Instruction

Use the Instruction tile to provide additional instructions to the workflow operator. The 
Instruction tile can also include entry fields for the operator to enter text or numeric data. 
These entries can later be used in the workflow. For instance, text entered by the operator can 
be added to a custom report.

File base name (only available if Append to File is not selected)

The file base name is added to the file name before the date and time.

File location The directory in which the file will be appended or created.

Tile name Sets the name of the tile in the workflow canvas.

Setting Description

Add Image Add an image that the operator will see on the instructions screen 
during the workflow. Valid file types include:

.PNG

.JPG

.GIF

.BMP

Add Text Box Use to add text. This is useful for providing instructions to the 
operator and for adding labels to text and numeric entry fields.

Add or Remove 
PDF

Provide a button that operators can click or touch to view a specified 
PDF. 

After adding the document button, click the button to specify the 
PDF file.

Add or Remove 
Cancel Button

Provides a cancel button that the operator can click or touch to stop 
the workflow.

+ Text Entry Allows the operator to enter text which can be used later in the 
workflow.

For example, the operator can enter a file path which can be used in 
the Archive tile.

+ Numeric Entry Allows the operator to enter a numeric value which can later be used as 
a variable in other tiles.

For example, the numeric value entered can be used in the Decision 
tile as the condition in a Numeric Value decision.

Setting Description
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Load Spectrum

Load a SPA file to use during the workflow. You can browse to a file location on the 
instrument computer or on a flash drive or network location or you can load a spectrum from 
the database.

This can be useful for importing a saved spectrum to use as a reference. For instance, you may 
want to import a reference spectrum to use in a subtraction operation.

Measure

Use the measure tile to measure the background and a sample and to set the measurement 
settings. Spectra and reports created during the workflow are saved to the database and can be 
archived with the Archive tile. 

+ Value Display data from a variable, such as match value of a result from a 
correlation search.

Tile Name Sets the name of the tile in the workflow canvas.

Setting Description

From file Load a SPA file from a location on your system or your network.

File name: Browse to a SPA file to include a spectrum.

From database Select to load a spectrum from the database. 

Selected spectrum: Choose a spectrum from the database.

Choose during workflow execution: Allow the operator to select a 
spectrum during the workflow.

Show only experiments containing this text: Limit the operator’s 
choice to only spectra that contain the specified text in the title or tags.

Tile name Sets the name of the tile in the workflow canvas.

Setting Description

Background 
settings

Specifies whether the workflow will prompt the operator to acquire a 
new background, use a spectrum from another tile in the workflow, or 
measure a background only, without measuring a sample.

Use internal 
polystyrene sample

If selected, an internal polystyrene reference sample installed in the 
instrument will be used to validate the instrument’s performance.

Use background 
prompt

Select to provide instructions to the operator before measuring the 
background. It is a good idea to instruct the operator to prepare to 
measure the background.

Setting Description
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Use sample 
prompt

Select to provide instructions to the operator before measuring the 
sample. You may want to instruct the operator to insert the sample.

Allow other 
workflows to access 
result of 
measurement

If selected, you can include spectra from this workflow in other 
workflows. For example, once this workflow is run and has measured a 
sample, a separate workflow could use the collected spectra as a 
reference spectrum or in a report.

Show spectrum 
during 
measurement

Select to view the spectrum during the measurement. If not selected, 
operators see only a progress indicator.

Progress text Provide a custom message to operators during the background and 
sample measurement.

Other 
Measurement 
Settings

Customize the measurement settings used in this workflow or match 
the settings used with another spectrum. 

Number of scans: The number of times that the sample will be 
scanned. More scans typically means for accurate data, but will take 
longer to measure.

Atmospheric suppression: Used to suppress the effects of CO2 and 
H2O. 

Match Settings: Select to match the measurement settings used with a 
specified SPA or QNT file. Select All Settings to review all of the 
settings used with this measurement.

Spectrum Title: Select to append variable data to the spectrum title.

See Measurement Settings and Advanced Measurement settings for a 
description of additional settings.

Tile name Sets the name of the tile in the workflow canvas.

Setting Description
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Peak Analysis

Analyze the Peak Height or the Peak Ratio of a spectrum. 

Setting Description

Peak Height Measure the height of a peak from zero absorbance (or 100% 
transmittance), without regard to the position of the baseline, or from 
the baseline. If measured from the baseline, the measurement is called 
the "corrected peak height."

Peak position: Enter the wavenumber of the peak to be measured.

Corrected: Select to measure the peak height from the spectral 
baseline rather than from zero absorbance (or 100% transmittance)

Reference point: Select for single-point correction, using one point as 
the baseline reference. 

Reference range: Select for two-point correction, using a point on 
either side of the peak to calculate the baseline. 

Generate pass/fail result: Select to create a pass/fail result that can be 
used in a Decision tile. 

Peak Ratio Find the ratio of height between two peaks. Peaks can be calculated 
from zero absorbance units or from a corrected baseline.

Not corrected: The peak heights are measured from zero absorbance 
(or from 100% transmittance)

Single-point corrected: The peak height will be measured from the 
baseline at the wavenumber you entered.

Two-point corrected: A point on either side of the peak will be used 
to calculate the baseline. 

Generate pass/fail result: Select to create a pass/fail result that can be 
used in a Decision tile. 

Select spectrum Select the spectrum that will be used in the peak analysis. You can 
choose from spectra generated in the workflow or imported with the 
Load Spectrum tile.

Tile name Sets the name of the tile in the workflow canvas
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Processing

The Processing tile includes several tools for processing spectral data, including subtraction, 
normalization, correlation, basic spectral math, and baseline correction.

Setting Description

Subtraction Subtract one spectrum from another. Spectral subtraction is 
useful in many instances. For example, if you are measuring a 
sample that is dissolved in a solvent, you can subtract a reference 
spectrum of the pure solvent to remove any peaks from the 
solvent. You can also identify an unknown contaminant in your 
sample by subtracting a known reference material, leaving you 
with only the contaminant. You can then use a correlation search 
to identify the contaminant. 

Sample spectrum The starting spectrum to which the operation will be applied.

Reference 
spectrum

The reference that will be subtracted from the starting spectrum. 

Subtraction type There are three types of subtraction available. Choose from 
subtraction by Factor, Pathlength, or Range.

Normalization Use Normalize to change the Y-axis scale of the selected spectra to 
a “normal” scale in which the Y values of the data points range 
from 0 absorbance units for the lowest point to 1 absorbance unit 
for the highest peak (for an absorbance-like spectrum) or from 
10% to 100% transmittance (for a transmission-like spectrum). 
These normal scales are typical of spectra in commercial spectral 
libraries.

After a spectrum is normalized, you cannot use it for quantitative 
analysis unless you know the scaling factor and adjust the 
quantitative results accordingly.

Select spectrum The starting spectrum to which the operation will be applied.

Max range (cm-1) Use to set the range used in the normalization.

Min range (cm-1) Use to set the range used in the normalization.

Target value Target value is specified in absorbance units. 

Correlation Returns the match value between the first and second spectrum. 
Like QCheck, the match value is given between 0.0 and 1.0, with 
1.0 reflecting a perfect match.

First spectrum Select the starting spectrum that the second spectrum is being 
compared to. 

Second spectrum Select a reference spectrum.
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Repeat

Loop a portion of the workflow to repeat steps.

Report

Create a custom report that can be stored, archived, or printed. Reports generated in the 
workflow are available in the Reports section of the dashboard.

Spectral range Use the spectral range to exclude totally absorbing peaks from the 
correlation search.

Basics Apply an operation to a single spectrum. 

Spectrum Select the spectrum to which the operation will be applied.

Operation Add
Subtract
Divide 
Multiply

Factor Increases or decreases the amplitude of the spectrum so that it can 
be better compared to another spectrum.

Baseline Correction Use to correct a baseline that is shifted.

Select spectrum Select a spectrum for which the baseline will be corrected.

Polynomial order Specify the polynomial order for the correction.

Tile name Sets the name of the tile in the workflow canvas

Setting Description

Repeat ___ times Sets the number of times that the looped portion of the workflow will 
repeat.

Tile name Sets the name of the tile in the workflow canvas.

Setting Description

Add image Add an image that the operator will see on the report screen during the 
workflow. Valid file types include:

.PNG

.JPG

.GIF

.BMP

Add text Use to add text. This is useful for providing instructions to the 
operator and for adding labels to text and numeric entry fields.

Setting Description
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Search

Perform a correlation or a multi-component search.

Add or remove 
document

Provide a button that operators can click or touch to view a specified 
PDF. 

After adding the document button, click the button to specify the 
PDF file.

Add spectrum Add a spectrum to the report. Select any spectrum generated or loaded 
earlier in the workflow.

Add value Add a value from another workflow tile to the report. For example, if 
the workflow included a measurement and a search, you can include 
data from the results of the search.

Add or remove 
print button

With a print button, operators can print the report while viewing the 
report screen.

Tile name Sets the name of the tile in the workflow canvas

Setting Description

Available libraries Drag libraries from the Available Libraries column to the Selected 
Libraries to use them in the search. 

Click Refresh to update the list of available libraries.

Search type Set the type of search that will be performed.

Correlation: Use to identify an unknown sample.
Number of results: Set the number of results that will be shown.

Multi-component: Use to identify the components of a sample.
Number of components: Set the number of components that will be 
shown.

Spectral Ranges Add a start and end value for the region that will be searched. 

Select spectrum Specify the spectrum that will be used in the search.

Tile name Sets the name of the tile in the workflow canvas

Setting Description
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Selection

With a Selection tile, the operator chooses which path the workflow should follow. 

Setting Description

Add image Add an image that the operator will see on the selection screen during 
the workflow. Valid file types include:

.PNG

.JPG

.GIF

.BMP

Add text Use to add text. This is useful for providing instructions to the 
operator.

Add value Add a value from another workflow tile to the report. For example, if 
the workflow included a measurement and a search, you can include 
data from the results of the search.

Selection label Edit the selection label to change the text that appears on the workflow 
canvas.
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Start

This is the first tile in every workflow. The Start tile is added to the workflow canvas 
automatically each time a new workflow is created.

Tag Spectrum

Apply a tag to spectra created during the workflow.

Setting Description

Workflow image Determines the image that is displayed when the workflow is run. 
Accepts a file path to an image file.

The following file types are valid:

.PNG

.JPG

.GIF

.BMP

Desired aspect 
ratio

Specify an aspect ratio to optimize the appearance of the workflow 
when it is run. The aspect ratio should match the display used by the 
operator as closely as possible.

Examples: 
4:3 for older computer monitors

16:9 is the standard for high-definition video and is common for 
current computer monitors

Accepts the following:
1:1
4:3
5:4
16:9
16:10
3:2
2:1

Setting Description

Tag Apply a tag to a spectrum.

Select spectrum Choose the spectrum to which the tag will be applied.

Tile name Sets the name of the tile in the workflow canvas.
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Template Report

Generate a report from a template. Reports generated in the workflow are available in the 
Reports section of the dashboard. Most of the settings for a template report depend on the 
template type that is selected.

TQ Analyst

Quantify the components of the sample using a specified quantification method.

Setting Description

Template type Choose from the following template types:

• ValPro style
• Single spectrum
• Multiple spectra
• Search results
• Single quantification
• QCheck
• Multiple run quantification

Automatically 
advance workflow 
after displaying 
report for 5 
seconds

If selected, the workflow will advance after displaying the report for 5 
seconds. If not selected, the operator manually continues the 
workflow.

Generate pass/fail 
result

If selected, specify text that will trigger a fail result. For example, if you 
specify “fail,” the template report tile will generate a fail result if the 
report includes the text “fail.”

Setting Description

Quantification 
method

Select a QNT file for the quantification method.

Select spectrum Select the spectrum that will be used for the quantification.

Tile name Sets the name of the tile in the workflow canvas.
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6

Create Reports

Generate reports from template to quickly save and share your data as Microsoft Word, 
PowerPoint, or Excel files. Or, export your spectra, workflows, and settings to share with your 
colleagues.

• Create and Share Reports and Export Data
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Create and Share Reports and Export Data
Generate reports from templates to quickly save or share your data as Microsoft™ Word™, 
PowerPoint™, or Excel™ files, or export your spectra, workflows, or settings.

 To create a report from the desktop interface

1. Select File > Create Report.

2. In the Output As dialog box, enter a title for your report and select a format and template 
option.The preview updates to match your selections. 

If you select Save as your format, your report data is saved to the database.

3. Click Create.

 To create a report from the touchscreen interface

1. From the spectral view, open the menu and select Create Report.

2. In the Output As dialog box, enter a title for your report, select a directory to save the 
report to, choose a format, and finally select a template. The preview updates to match 
your format and template selection.
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If you select Save as your format, your report data is saved to your database.

3. Touch Create.

Export Settings, Spectra, or Workflows

Use OMNIC Paradigm software for desktop to export settings and workflows. Export spectra 
in either desktop or touchscreen mode.

 To export settings

1. Select the settings you wish to export from the Settings list.

2. Select Acquire Data > Export Settings.

3. Name the settings file and click Save.

Settings are saved with a .expx file extension. These settings files store your measurement 
settings but not Search, QCheck, or Quantification settings. Settings files with a .expx file 
extension are not compatible with previous versions of OMNIC software.
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 To export workflows

• If you are using the desktop interface

a. In the Workflows pane, right-click the workflow you wish to export and select 
Export from the menu.

b. Name your workflow file and click Save.

Workflow files are saved with a .rwfl file extension.

c. In the Measurements pane, right-click the spectrum you wish to export and select 
Export.

d. Name your spectrum file and click Save. Spectra are saved with a .spa file extension. 

• If you are using the touchscreen interface

a. From the home screen, select the Measurements tab.

b. Open the more options menu [ ] and select Export.

c. Touch Save. Spectra are saved with a .spa file extension.
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7

Protect Your Data

OMNIC Paradigm software pairs with Security Suite software to ensure your data integrity 
and security. 

• Data Security and Integrity with OMNIC Paradigm Software
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Data Security and Integrity with OMNIC Paradigm Software
To ensure the security and integrity of your data and to help your lab comply with 21 CFR 
Part 11 or other regulations, pair the OMNIC™ Paradigm software with Thermo Scientific 
Security Suite software.

Security Suite is a comprehensive data security toolset, allowing you to perform the following 
tasks:

• Limit and control access to features and tools in the OMNIC Paradigm software and 
other instrument applications.

• Set and manage security policies to ensure proper data handling.

• Customize and enforce digital signatures to establish responsibility. 

• Log and view security events. 

You can purchase Security Suite software to manage a single system or to manage multiple 
instruments distributed on a network. After installation, configuring the OMNIC Paradigm 
application for security takes only moments.

For a discussion of how Security Suite software can help you comply with 21 CFR Part 11, see 
21 CFR Part 11 Compliance.
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